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Introduction to Project Management
HP Project Management enables organizations to streamline and standardize 
the management of project activities using a template-based, collaborative 
approach.

Project Management defines the step-by-step processes required to complete 
specific tasks and deliverables, guiding users through a dynamic, 
self-documenting process to support activities such as the execution of 
standardized checklists or the collection of deliverables using document 
attachments. For more information on setting up project processes and related 
items, see Chapter 2, General Setup Considerations, on page 21.

Using project types, the business rules that govern a project or set of projects 
can be formalized. Policies can be set governing various aspects of a project, 
including schedule health, task auditing, and project security. At least one 
project type must be created before you can create and manage projects. For 
more information on setting up project types, see Chapter 3, Configuring 
Project Types, on page 35.

When creating a project, you may be able to adjust policies handed down by 
the project type, as well as decide whether to include a work plan, budget, or 
staffing profile. Project security can also be defined. See Chapter 4, Creating a 
Project, on page 57, for more details on creating a project.

Work plans can be defined as hierarchical structures of summary tasks that 
logically group and organize tasks or activities. See Chapter 5, Creating a 
Work Plan, on page 65, for details on creating a work plan. Once the work plan 
structure is in place, task details can be configured in batches or one at a time, 
depending on the nature of the changes. See Chapter 6, Configuring Tasks, 
on page 91, for more details on task-to-task navigation.

Work plan templates can also be used to create pre-set work plan structures 
that are ready to use. See Chapter 9, Using Work Plan Templates, on page 173, 
for more details on the use of work plan templates, including converting 
existing work plans into templates.

As the project executes, managers can make use of the Project Overview page 
to view important project metrics such as health indicators, milestones, and 
issues. See Chapter 7, Managing a Project, on page 111, for details on the use 
of the Project Overview page as well as project management activities such as 
taking baselines and revising the work plan.

Project teams can easily manage work plan activities within and across the 
technology chain because all team members, whether internal or external, 
collaborate and interact through an intuitive interface. Chapter 8, Updating 
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Tasks: Resource Activities, on page 155, explains how resources on a project 
locate, update, modify, and report on tasks to which they are assigned.

For example, when creating a new and updated version of a business system, a 
company could classify its efforts into summary tasks for each major 
functional area.

Each of these functional summary tasks could be further broken down into 
tasks directed to areas such as web content, application and database tasks.

These tasks can be linked to requests and packages from HP Demand 
Management and HP Deployment Management, giving instant visibility to 
more detailed activities supporting an overall work plan. Tasks can also 
have constraints and notifications configured on an individual basis. See 
Chapter 6, Configuring Tasks, on page 91, for more information.

In conjunction with HP Resource Management, role and skill assignments 
can be tracked against resource availability. Resource utilization can also 
be measured, visualized, and optimized.

In conjunction with HP Time Management, time sheets can be used for 
actuals reporting on project-related work. See Chapter 11, Integration with 
HP Time Management, on page 209, for more details.

As the project executes, risks, issues, and proposed scope changes can be 
submitted along preconfigured project control processes and tracked at the 
Project Overview level.

As the project executes, different sets of users may be called upon to 
evaluate and move the project along its pre-defined lifecycle.

Baselines of the work plan can be taken at any time, providing a basis for 
work plan performance comparisons.

Work plan cost data is tracked at the task level, and can be used to analyze 
trends and patterns via earned value analysis. Costs can be automatically 
calculated or manually entered, and actual costs can be automatically rolled 
up into the project budget.

Project Management also supports standard integration with Microsoft® 
Project so that functions such as task scheduling and resource management 
can be utilized at any point during a work plan’s execution. See 
Chapter 10, Integrating Project Management with Microsoft Project, 
on page 179, for more detailed information.

To make use of their full range of features, resources and resource-related 
configurations should be set up in Resource Management prior to using Project 
Management. For more detailed information, see Chapter 2, General Setup 
Considerations, on page 21, or the HP Resource Management User’s Guide.
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Related Documents
Related documents for this book are:

HP Demand Management User’s Guide

HP Deployment Management User’s Guide

HP Resource Management User’s Guide

HP Time Management User’s Guide

HP Time Management Configuration Guide

Security Model Guide and Reference
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2 General Setup Considerations

In This Chapter:

Overview of General Setup Considerations
Setting Up Resources
Setting Up Regions
Configuring HP Project Management Validations
Configuring the Project Details Tab
Configuring the Project Process
Configuring Project Control Processes
Setting Up Project Types
Setting Up Activities
Setting Up Task User Data
Setting Up Time Management Integration
Setting Up Microsoft Project Integration
21



Overview of General Setup Considerations
There are several configuration steps that should be completed before you start 
to make use of HP Project Management. Some of these steps are required in 
order for you to take full advantage of HP Project Management functionality; 
others are optional depending on how much you want HP Project Management 
to fit your business processes.

In general, the configuration and setup work is as follows:

1. Set up resources and resource pools.

HP Resource Management allows you to create resource information for 
each user of HP Project and Portfolio Management Center, including 
details such as:

Role

Skill profile

Organization unit

Individual resource calendar

In order to assign a resource to a project’s staffing profile or work plan, the 
resource must belong to a resource pool you manage. Resources that 
belong to other resource pools can be requested using standard staffing 
profile functionality.

See Setting Up Resources on page 25 for more details on this step.

2. Set up regions.

Regions are associated with each project and resource. They define 
attributes such as:

Calendar

Holidays

Normal working days and hours

Default currency

See Setting Up Regions on page 26 for more details on this step.
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3. (Optional) Configure HP Project Management validations.

Lists of values for certain fields can be tailored to suit your business needs 
through validations, which can be edited in the PPM Workbench.

See Configuring HP Project Management Validations on page 27 for more 
details on this step.

4. (Optional) Configure fields displayed in the Project Details tab in the 
Project Overview page.

The fields in the Project Details tab are preconfigured content, but they can 
be modified to suit your business needs. At a minimum, the security 
settings for these fields should be reviewed.

See Configuring the Project Details Tab on page 29 for more details on 
this step.

5. (Optional) Configure the project process in the PPM Workbench.

The project process is modeled in a preconfigured workflow that can be 
configured in the PPM Workbench to suit your business needs. At a 
minimum, the security settings for the workflow and its steps should be 
reviewed.

See Configuring the Project Process on page 30 for more details on this 
step.

6. (Optional) Configure project control processes.

Project issues can be submitted against a particular project to raise issues 
that require attention. Once submitted, project issues follow their own 
workflow to resolution. Project issue fields and behavior, as well as the 
underlying workflow, can be configured in the PPM Workbench to suit 
your business needs. Similar management tools are provided for project 
risks and scope changes.

See Configuring Project Control Processes on page 30 for more details on 
this step.

7. Set up project types.

Every project is created from a project type, which contains project policies 
that you can preconfigure for ease of use, or even lock down when 
appropriate. In order to create a project, you must first configure at least 
one project type. The Enterprise project type comes preconfigured, but 
should be reviewed to ensure that it suits your business needs.

See Setting Up Project Types on page 32 for more details on this step.
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8. (Optional) Set up activities.

Tasks in the project work plan can be associated with activities, which can 
be used for Statement of Position (SOP) 98-1 tracking, classifying tasks as 
capital or operating expenses when they are actualized. If you choose not to 
activate SOP 98-1 tracking, activities can still be associated with tasks as a 
categorization tool.

See Setting Up Activities on page 32 for more details on this step.

9. (Optional) Set up integration with HP Time Management.

Setup for Time Management integration is mostly done on the project type 
level, but before using Time Management for reporting on project-related 
work activities, you should ensure that each resource has the proper 
permissions and delegations set up in Time Management. See the HP Time 
Management User’s Guide and HP Time Management Configuration 
Guide for more information.

10. (Optional) Set up integration with Microsoft Project.

HP Project Management can integrate with Microsoft Project. In order to 
take advantage of this integration, there are a few server settings that must 
be configured.

See Setting Up Microsoft Project Integration on page 34 for more details 
on this step.

11. (Optional) Set up task user data.

Task user data are custom fields that can be associated with every task in 
HP Project Management.

See Setting Up Task User Data on page 33 for more details on this step.
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Setting Up Resources
Resources in HP Project Management can be tracked to optimize their time 
and capabilities with HP Resource Management. HP Resource Management 
allows a project manager to:

Set a calendar for each resource, determining total availability as well as 
specifying vacation days

(Optional) Assign a primary skill and role to a resource

View resource load by time period, work plan, or individual

Analyze and search resource availability

Resource pools can be used to track the supply of resources and are also 
necessary for work plan assignments. Each resource expected to be assigned to 
a project staffing profile or directly to a work plan must belong to a resource 
pool managed by the project manager. Either of the following project resource 
management strategies can be employed:

If your resources are not being actively managed, you can place all possible 
project resources into a single resource pool and designate all possible 
project managers as the resource pool’s managers. This allows you to 
select any resource for your project staffing profile or work plan.

If your resources are being actively managed in such a way that their time 
must be requested from their managers, a staffing profile should be used. 
This allows you to request resources from a resource pool you don’t 
manage using HP Resource Management functionality. The resource’s 
manager will approve or reject the request.

Resources (including calendar information) and resource pools should be set 
up in HP Resource Management before creating a project in HP Project 
Management. Roles and skills should also be set up even if you do not intend 
to associate them with resources.

See the HP Resource Management User’s Guide for detailed information on 
how to perform these tasks.

Cost rates for individual resources are set using cost rate rules, which are 
controlled through HP Financial Management. See the HP Financial 
Management User’s Guide for detailed information on cost rate rules and their 
setup.
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The following useful tasks can also be performed using HP Resource 
Management:

Mapping of resources into an organization model and tying organization 
units to security groups

Projecting the allocation of resources over time using staffing profiles

See the HP Resource Management User’s Guide for additional details.

Setting Up Regions
Regions are set up in HP Resource Management and contain their own 
calendars. These regional calendars specify the following:

Number of hours in a working day

Working days for each week

Holidays

A project can then be associated with a region for accurate project and resource 
scheduling.

See the HP Resource Management User’s Guide for detailed information on 
setting up regions and regional calendars.
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Configuring HP Project Management Validations
Values for certain fields in PPM Center are controlled by validations that are 
configurable or extensible. To change the list of possible values in a field, you 
must open its validation in the PPM Workbench and edit it from there.

The Business Unit field on the Project Details tab of the Project Overview page 
is an example of a static list validation, which provides a static list of options to 
the user. A static list validation can be a drop-down or an auto-complete list 
component. 

To add values to the validation list:

1. Log on to PPM Center and open the PPM Workbench.

2. From the shortcut bar, click Configuration > Validations.

3. On the Query tab of the Validation Workbench window, click List.

The Results tab opens, displaying the results of the search.

4. Select PFM - Business Units and click Open.

The Validation window opens with the Business Unit field’s validation 
loaded.

5. Click New.

The Add Validation Value window opens.

6. Provide information for the validation value as described in the following 
table. 

Configurable or extensible validations only exist for fields associated with the Project 
Details tab of the Project Overview page and the project control processes. Values for 
work plan fields cannot be changed.

Field Definition

Code
The underlying code for the validation value. The code is the 
value stored in the database or passed to any internal functions, 
and is rarely displayed. 

Meaning The displayed meaning for the validation value in the drop-down 
list or auto-complete.
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7. (Optional) Set the validation value as the default by selecting the Default 
field. 

The default option is only available for drop-down lists.

8. Click OK to close the window and add the value to the validation. Click 
Add to add the value and keep the Add Validation Value window open.

Validation values can be re-ordered using the up and down arrow icons. 
The sequence of the validation values determines the order that the values 
are displayed in the list.

9. When you are done adding values to the validation, click Save or OK in the 
Validation window to save the new values.

For more information on editing and creating validations of various types, see 
the “Working with Validations” chapter in the Commands, Tokens, and 
Validations Guide and Reference.

Desc A description for the validation value.

Enable? Determines whether the validation value is enabled. This should 
be checked if you want the value to appear in the field.

Default
Determines whether the value is the default value for the list. This 
value is initially displayed in drop-down lists (this is not used for 
auto-complete lists). There can be only one default value per list.

Field Definition

You can copy existing values defined in other validations using the Copy From 
button. Click Copy From and query an existing list-validated validation and choose 
any of the validation values. Click Add or OK in the Copy From window and the 
selected value or values are added to the list.

Be careful when creating validations (drop-down lists and auto-complete lists) that 
are validated by lists. Each time the set of values changes, you will be forced to 
update the validation. Consider, instead, validating using a SQL query or PL/SQL 
function to obtain the values from a database table. 
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Configuring the Project Details Tab
The Project Details tab of the Project Overview page contains fields delivered 
as preconfigured content for projects.

Figure 2-1. Project Overview page: Project Details tab
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These fields do not need to be set up or altered in any way before you start 
using HP Project Management, but if you want to change them, they can be 
customized to suit your business needs in the following ways:

Individual field names and values can be changed.

Fields themselves can be configured to be hidden, visible, or read-only 
depending on what stage has been reached in the project process, which is 
driven by the workflow discussed in Configuring the Project Process.

These fields and their workflow interactions are contained and defined by a 
request type that can be altered in the PPM Workbench.

For detailed discussion of this request type and workflow configuration, see 
the HP Project Management Configuration Guide.

Configuring the Project Process
The project process is determined by a workflow in PPM Center. This 
workflow is delivered as best-practice content ready for you to use in HP 
Project Management, but if you want to change it, it can be customized to 
match your organization’s project execution process. Steps in the workflow 
can also be configured to integrate with fields on the Project Details tab in the 
Project Overview page, determining whether they are visible or editable.

For detailed discussion of this request type and workflow configuration, see 
the HP Project Management Configuration Guide.

Configuring Project Control Processes
HP Project Management includes specialized project control items that can be 
submitted and managed during project execution as HP Demand Management 
requests:

Issues can be filed against a particular project to raise issues that require 
attention.

Risks can be brought up to highlight risks that may endanger project 
execution.

Scope changes can be requested to adjust the scope of the project.
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Figure 2-2. Project scope change

Once submitted, these requests follow their own workflows to resolution. Each 
request type and its workflow are delivered as best-practice content ready for 
you to use, but if you want to change them, they can be customized to match 
your project control processes. The following project control request aspects 
can be changed to suit your business needs:

Individual fields and possible values can be changed.

Fields themselves can be configured to be hidden, visible, or read-only 
depending on what stage has been reached in the workflow.

The workflows can be changed.
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For detailed discussion of these project control request types and workflow 
configuration, see the HP Project Management Configuration Guide.

Setting Up Project Types
All projects are created from project types. A project type is used to default or 
impose the business rules that will be used to manage a new project. Project 
types include policies for different aspects of managing the project, including:

What types of actuals are collected 

Whether built-in project costing or HP Time Management are used for the 
project

Whether the project will include a work plan

Project types and their policies must be set up before you can begin creating 
projects. For detailed discussion of configuring project types, see Chapter 3, 
Configuring Project Types, on page 35.

Setting Up Activities
Activities are simple configuration entities that can be associated with tasks in 
the project work plan. Activities marked as capitalized are used in this capacity 
for Statement of Position (SOP) 98-1 tracking, and will categorize the costs of 
associated tasks as capital if the project supports capitalization. If you choose 
not to activate SOP 98-1 tracking, activities can still be associated with tasks as 
a categorization tool, and any associated costs will be considered operating 
expenses.

You do not need to configure activities nor associate them with tasks if you are 
not interested in SOP 98-1 tracking, or if you do not wish to track task 
categories to this level of granularity. HP Project Management comes with a 
pre-defined set of activities reflecting common SOP 98-1 categories that can 
be configured for use with tasks.

For detailed discussion of configuring activities and activity behavior, see the 
HP Financial Management User’s Guide.
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Setting Up Task User Data
Task user data are custom fields that can be associated with every task on a 
work plan. If you have no need of custom fields for tasks on your work plans, 
then you do not need to configure task user data.

For detailed discussion of task user data setup, see the HP Project 
Management Configuration Guide.

Setting Up Time Management Integration
HP Time Management can be used in conjunction with HP Project 
Management for detailed entry of time and effort actuals using time sheets. 
Time sheets have their own sets of approvers and approval processes, and can 
be used for more granular cost reporting.

Setup for Time Management integration is mostly done on the project type 
level, but before using Time Management for reporting on project-related work 
activities, you should ensure that each resource has the proper permissions and 
delegations set up in Time Management. See the HP Time Management User’s 
Guide and HP Time Management Configuration Guide for more information.

A few configuration tasks must be completed before using HP Time 
Management with HP Project Management. They are as follows:

Ensure that users who will be updating project actuals through Time 
Management have the proper licenses and access grants

Ensure that project managers have the proper access grants to approve time 
sheets submitted by users

For each project, ensure that the proper project settings have been 
configured for Time Management integration

For detailed discussion of HP Time Management integration, see Chapter 11, 
Integration with HP Time Management, on page 209.
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Setting Up Microsoft Project Integration
HP Project Management integrates with Microsoft Project, allowing you to 
create a work plan in either application and synchronize scheduling and actuals 
information between the two. For example, if you are more comfortable 
creating work plans in Microsoft Project, but want to take advantage of HP 
Project Management’s project participant functionality (such as the My Tasks 
portlet), you can create a work plan in Microsoft Project and send it to HP 
Project Management.

There are a few tasks that must be completed before using HP Project 
Management with Microsoft Project. See the HP Project Management 
Configuration Guide for more details.

For more detailed discussion of Microsoft Project integration, see Chapter 3, 
Configuring Project Types, on page 35.
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3 Configuring Project Types

In This Chapter:

Overview of Configuring Project Types
Project Types
Project Policies

Working with Project Types
Setting Project Policies

Project Fields
Work Plan
Request Types
Scheduling
Schedule Health
Cost and Effort
Cost and Earned Value Health
Microsoft Project Integration
Staffing Profile Assignments
Project Health
Issue Health
Task Auditing
Project Security
35



Overview of Configuring Project Types
This chapter discusses project types and project policies, and gives instructions 
on how to create and modify them.

Project Types
Each project is associated with a project type on creation. A project type is 
used to default or impose the business rules, or Project Policies, that will be 
used to manage a new project. At least one project type must be created in 
order for you to be able to create projects in Project Management, though an 
Enterprise project type is included with Project Management upon installation.

You can define ownership of each project type, allowing you to control which 
users can make changes to that project type. This can be useful when multiple 
organizations within a business maintain their own project types. You can also 
define limits on who can use a given project type to create projects. Project 
types can be copied. Project types can also be disabled, but any project 
currently using that project type will be unaffected.

Project Policies
A project type includes policies for a project concerning:

Which health metrics will be tracked for the project, as well as threshold 
levels for each health color

Security and audit controls for the project

The request type that will define the fields on the Project Details tab and 
drive the project process

Costing exception rules that will be used to calculate indicators showing 
costing and earned value violations

Whether the project will include a work plan

What types of actuals are collected

Rules that govern work plan scheduling

Scheduling exception rules that will be used to calculate indicators 
showing a scheduling problem

Whether built-in project costing or HP Time Management are used for the 
project

Settings for Microsoft Project integration
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Settings dictating the items that count as workload for resources for the 
project

The project type and its policies determine a project’s settings.

Enforcing Project Policies

For each policy, the project type determines whether projects using the project 
type will be allowed to modify the associated settings. When you create a 
project using a project type with overridable policies, you can change the 
corresponding settings on that project as needed.

For example: A project type called “Alpha Project” is created for Company A. 
“Alpha Project” has an overridable Cost and Effort policy. A manager creates a 
project using the “Alpha Project” type, and changes the Cost and Effort settings 
to suit the needs of the project at hand. The manager cannot change any other 
settings, as they are non-overridable.

For projects that are already in progress, changing a project type policy or its 
override status has the following effects:

Changing an overridable policy to non-overridable will change that policy 
for projects in progress, switching their settings to match the new policy if 
settings were altered previously.

Changing a non-overridable policy to an overridable policy has no effect 
on projects in progress.

Making a change to a non-overridable policy changes the settings on 
projects in progress to match the new policy.

Making a change to an overridable policy has no effect on projects in 
progress.

In cases where changes to a project type will cause recalculation of data, such 
as changes to exception thresholds, these calculations are deferred for 
processing.

Making Changes to Policies that Do Not Propagate

Certain policies do not propagate changes to existing projects, even if they are 
set to be non-overridable. These policies are:

Cost and Effort

Microsoft Project Integration

Work Plan Template (changes do propagate, but do not alter existing work 
plans)
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If you want to make changes to a project type policy that does not propagate, 
following the general procedure outlined below:

1. Identify a time when system activity is low.

2. On the project type, unlock the project policy.

3. Open existing projects and change the settings on each where allowed.

4. On the project type, lock the project policy.

Working with Project Types
To create a project type:

1. Log on to PPM Center.

2. From the menu bar, select Administration > Project Types & Templates > 
Create a Project Type.

The Create Project Type page opens.

3. Type a Project Type Name and, optionally, a Description.

4. Set the desired project policies as described in Setting Project Policies.

5. Click Create.

Setting Project Policies
Project policies are grouped into related areas. These policies become the 
settings for a project created from the project type they belong to.

To set project policies, click the button corresponding to the policy you want to 
edit and make the necessary changes before clicking Save.

Project Fields
The Project Fields policy controls the fields tracked by a work plan. Selecting 
the checkbox or option next to a field activates it. Some fields contained in the 
Project Fields policy are required in order for you to take full advantage of HP 
Project Management functionality, and should be left active.
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Figure 3-1. Project Fields policy

Table 3-1 describes the fields controlled by the Project Fields policy.

Table 3-1. Project Fields policy (page 1 of 2)

Field Name Description

Schedule Fields section

Scheduled Start The scheduled start for a task.

Scheduled Finish The scheduled finish for a task.

Scheduled Duration The scheduled duration for a task.

Scheduled Effort Allows you to specify scheduled effort per task. This 
field is controlled by the Cost and Effort policy.

Actuals Fields section

% Complete The amount of the task that has been completed.

Actual Start The date at which work on the task actually begins.

Actual Finish The date at which work on the task actually ends.

Actual Duration The actual duration of the task, calculated from the 
Actual Start and Finish.
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Work Plan
The Work Plan policy allows you to specify whether a project will have a work 
plan, as well as suggest or enforce a specific work plan template to be used 
with the project type. This policy’s override behavior is as follows:

If you specify a work plan template in the Work Plan Template field and set 
the policy to non-overridable, a project created from this project type can 
only create a work plan based on this work plan template. Moreover, the 
default work plan template cannot be changed.

If you specify a work plan template in the Work Plan Template field and set 
the policy to overridable, the manager for a project created from this 
project type can choose to create the work plan from the default template, 
another template, or manually.

If you do not specify a work plan template, the policy is set to overridable 
by default. This should be done for project types that do not require a 
specific work plan template.

For more detailed information on work plan templates, see Chapter 9, Using 
Work Plan Templates, on page 173.

Actual Effort Allows you to enter actual effort values for each task. 
This field is controlled by the Cost and Effort policy.

Estimated Remaining 
Effort

Allows you to specify an estimated remaining effort 
value for each task. This field is controlled by the 
Cost and Effort policy.

Estimated Finish Date Allows you to specify an estimated finish date for 
each task.

Additional Fields section

Activity Allows you to assign an activity to a task; used 
primarily for SOP 98-1 tracking.

Role Allows you to specify a role for each task.

Milestone Display section

Major Milestones Allows you to identify tasks as “major milestones” 
that appear on the Project Overview page.

Table 3-1. Project Fields policy (page 2 of 2)

Field Name Description
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Figure 3-2. Work Plan policy

Request Types
The Request Types policy specifies the following items:

The request type that controls the fields which appear in the Project Details 
tab of the Project Overview page. This request type is also associated with 
the workflow that drives the overall project process. This item is required.

If you have installed HP Portfolio Management, this request type will also 
represent the project in your portfolio. See the HP Portfolio Management 
Configuration Guide for more details.

The request type (and, implicitly, the associated workflow) used to report 
and resolve project issues.

The request type (and, implicitly, the associated workflow) used to report 
and resolve project risks.

The request type (and, implicitly, the associated workflow) used to report 
and resolve project scope changes.

Figure 3-3. Request Types policy
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Scheduling
The Scheduling policy specifies options that govern how the work plan is 
scheduled, including:

Default start date to schedule the work plan from

Resource dependency

Critical path threshold

Scheduling warning rules

Figure 3-4. Scheduling policy
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Default Start Date

This part of the Scheduling policy controls the default start date from which 
tasks are scheduled. This is set on each project, regardless of whether the 
policy is set to non-overridable. This is used to set a consistent date from which 
to schedule the work plan, no matter what occurs during the planning process.

The policy also determines whether the scheduler considers existing actual 
start and finish dates for tasks when rescheduling. By default actual dates are 
considered.

For example, once a work plan becomes Active, its tasks can be marked In 
Progress. When tasks are marked In Progress, actual start dates are specified 
for that task. If the project is set to use actual start/finish dates in scheduling, 
the In Progress tasks will move to start on their actual start dates.

Resource Dependency

Every business initiative has some minimum resource requirements, usually in 
the form of available personnel. HP Project Management checks to ensure that 
resources are assigned on their working days. The Include days in schedule 
when options can be set to consider resource requirements when creating the 
work plan schedule. For instance, it is possible for the Scheduling policy to set 
the project to ignore resource availability and schedule accordingly.

The default configuration is set to require all resources to be available on any 
given day. When creating the work plan schedule, HP Project Management 
will only consider days when all resources are present.

Critical Path Threshold

A work plan's critical path is the series of tasks that determines the duration of 
the project. The Critical Path Threshold is the amount of slack (the amount of 
time that a task may be delayed from its start without delaying the project) 
specified as the threshold for identifying a task as part of the critical path. 
Tasks with slack less than or equal to this value are on the critical path. Use of 
a threshold allows the project manager to control the degree of risk tolerated in 
management of the work plan.

Schedule Warning Rules

You can select which Schedule Warning Rules are used to alert the project 
manager about potential structural problems when scheduling a work plan. 
Schedule warnings are calculated whenever task data is saved, so they can be 
used even without using the scheduler.

HP Project Management will only issue warnings based on the schedule warning rules 
you have selected.
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Schedule Health
The Schedule Health policy controls the project’s schedule health indicator, as 
well as determining the active exception rules for a project.

Figure 3-5. Schedule Health policy

Schedule Health Indicator

The project’s schedule health indicator is a simple color-coded indicator of the 
health of a work plan. A project only has a schedule health indicator when the 
work plan is Active; it disappears when the work plan is completed or put On 
Hold. A project’s schedule health indicator color begins green and changes to 
yellow or red depending on the percentage of tasks identified as contributing to 
work plan health that have triggered exceptions (completed tasks are ignored). 
This percentage is configured by this policy. A project’s schedule health 
indicator will not be calculated until the project is saved.

For example: A project is created from a project type whose Scheduling 
Exception Rules policy sets the threshold value for yellow to 30%. Four tasks 
trigger an exception in a work plan consisting of ten tasks total. The schedule 
health indicator turns yellow, and will remain yellow until at least two tasks are 
reworked until they no longer trigger exceptions (this could be accomplished 
by changing a start date, or modifying resources, or starting the tasks). Once 
this occurs, the schedule health indicator turns green.
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Scheduling Exception Rules

Projects come with a set of predefined exception rules. The Schedule Health 
policy can specify which exception rule(s) are to be enabled, as well as the 
criteria needed to trigger them. As discussed above, the policy can also set the 
schedule health indicator, which is a simple color-coded indicator of the 
schedule health of a project. The schedule health indicator watches for 
schedule exceptions that have been triggered, and changes color according to 
the policy.

This can be a good way to keep track of high-risk projects. For example, for a 
project type with a very low margin for error, the policy can set the percentage 
of triggered exceptions needed to change the schedule health indicator red to 
20, giving clear early warning of problems.

The Schedule Health policy controls the exception rules relating to project 
scheduling and execution.

The following parameters for almost all exception rules are configurable:

Enabled. Project managers can decide whether or not the particular 
exception rule is enabled.

Rule (number of days). Specifies the number of days the particular 
exception rule waits for or monitors.

Include in Health. Decides whether or not the violations of the particular 
exception rule are included in the schedule health indicator (see Schedule 
Health Indicator).

Each exception rule within the policy can be configured independently.

Cost and Effort
The Cost and Effort policy dictates how the costs, effort, and workload for the 
project will be managed, including how this information flows between project 
entities such as the work plan, staffing profile, budget, and time sheets, if any. 
The policy determines whether financial information will be tracked for 
projects, how actuals are captured, and how costs are calculated. If you have 
installed HP Time Management to capture actuals, this policy controls the 
Time Management settings for a project type. If you do not have HP Time 
Management or choose not to use it, you can select and configure HP Financial 
Management options.
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Figure 3-6. Cost and Effort policy
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Resource Load Settings

HP Resource Management automatically keeps track of resource workload and 
availability. These settings determine how to track workload for a project type.

HP Resource Management allows you to attach a staffing profile to a project to 
track resource demand and usage. You can choose between the following 
options:

Staffing Profile represents the work load imposed by the project. You can 
then choose whether to enter actuals on the staffing profile manually, or 
roll actuals from the work plan or HP Time Management up to the staffing 
profile. In order for rollup to work, you must enable the tracking of actual 
effort in this policy, described in Actual Effort in the Work Plan. For more 
information on staffing profiles, see the HP Resource Management User’s 
Guide.

Work plan task assignments respresent the load imposed by the project. In 
order for this option to be selected, you must enable the tracking of 
scheduled and actual effort in the work plan, described below.

Scheduled Effort in the Work Plan

You can decide whether to track the scheduled effort needed to accomplish 
each task in the work plan. This is required if you are setting the project to 
automatically calculate the planned cost of tasks (set in the Cost and Effort 
policy under Financial Management), or if the work plan task assignments are 
set to represent resource load (set in the Cost and Effort policy under Resource 
Load Settings).

If you decide to Use Scheduled Effort during planning, you can then choose to 
have the system automatically calculate it, or enter it manually. Additionally, 
you can choose to allow the calculation method to be changed in the work plan 
on a task-by-task basis.

Actual Effort in the Work Plan

You can decide whether to track actual effort per resource assignment during 
the execution of a project. This is required when automatically calculating 
actual costs, when using HP Time Management to track actuals for the work 
plan, or when work plan task assignments represent resource work load.

If you decide to Capture Actual Effort per resource assignment, you can also 
choose whether to Capture Estimated Effort per resource assignment. This 
setting cannot be used in conjunction with HP Time Management if you are 
tracking time at anything other than the task level, nor can it be changed once 
actuals have been captured.
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Time Management

If you choose to enable HP Time Management for this policy, there are a range 
of options to configure, described in Table 3-2.

Table 3-2. Cost and Effort policy: Time Management settings

Field Name Description

Use Time 
Management to ...

Enables tracking of actuals using HP Time Management 
time sheets.

Track time at the ...

Specify whether to track time at the task, summary task, 
or project level.
You can specify the summary task hierarchy level to track 
down to.
If you are using HP Time Management to track actuals 
and are also capturing estimated effort, you can only 
track time at the task level.

Allow the following ...

Specify whether you want Project resources, All 
resources, or only Assigned resources to track time.

Project Resources indicates that resources assigned 
to tasks on the work plan or who appear on the staffing 
profile can log time on any task.
Assigned Resources indicates that only resources 
who are assigned to a task can report time on those 
tasks.
All resources indicates that any resource who can 
see the project (including stakeholders) can log time 
for any task.

Allow time to be 
logged after ...

Specify whether time can be logged after a task 
completes, and if so, for how long.

Time logged against 
this project ...

Specify whether time logged against the project needs to 
be approved by a project representative.

Project Time Approver Specify who can approve time logged against the project, 
either by participant group or specific security group.
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Financial Management

HP Financial Management can calculate certain costs automatically depending 
on the fields that are enabled:

In order to automatically calculate planned costs for the work plan, you 
must first enable the Scheduled Effort field as described in Scheduled 
Effort in the Work Plan.

In order to automatically calculate actual costs for the work plan, you must 
first enable the Actual Effort field as described in Actual Effort in the Work 
Plan.

If you choose to enable HP Financial Management for this policy, there are a 
range of options to configure, described in Table 3-3.

Table 3-3. Cost and Effort policy: Financial Management settings

Field Name Description

Allow capitalized 
costs ...

Specify whether the project will track capitalization for costs, 
identifying all costs as either capital or operating expenses 
according to the activity assigned to each task.
Changes to this setting will affect the capitalization tracking 
for the budget associated with the project, if one exists.
Capitalization information will only be tracked if 
capitalization tracking has been enabled on the PPM Server. 
See the HP Financial Management User’s Guide for more 
detailed information.

Enable Financial 
Management for 
Work Plan

Enables tracking of work plan costs using HP Financial 
Management.

Planned costs will 
be:

Specify whether planned costs will be automatically 
calculated based on scheduled effort and rates, or manually 
entered.

Actual labor cost 
will be:

Specify whether actual labor cost will be automatically 
calculated based on actual effort and rates, or manually 
entered.

Roll up actual 
costs ...

Specify whether actual cost values will roll up to the budget 
associated with the project, if any. You can choose to roll up 
labor and non-labor costs, actual costs only, or no cost data 
at all.
Configuring Project Types 49



Cost and Earned Value Health
The Cost and Earned Value Health policy controls whether to track the cost 
health for a project, and if so, which metrics will be evaluated to determined 
health. It is used to indicate the health of a project in terms of its cost. Project 
cost health is calculated in the following areas:

If CPI is less than. CPI, the Cost Performance Index, is the cost efficiency 
ratio of the project’s Earned Value (Baseline Costs * % Complete) to 
Actual Costs. CPI is calculated as Earned Value / Actual Cost. For a 
healthy project, CPI should be near 1.

If SPI is less than. SPI, the Schedule Performance Index, is the difference in 
value between the scheduled completion of a task/project and its actual 
completion. SPI is calculated as Earned Value / Planned Value. For a 
healthy project, SPI should be near 1.

If actual costs exceed the prorated budget by. This is a comparison of 
project costs to date with the portion of the budget planned to have been 
spent to date.

Any one of these factors can be enabled or disabled when calculating work 
plan cost health, but if more than one factor is enabled, the indicator represents 
the factor in the worst condition. If one factor out of three turns red, the cost 
health turns red.

Figure 3-7. Cost and Earned Value Health policy

Table 3-4 details the default color change values for each relevant cost health 
factor.

Table 3-4. Default color change values for cost health indicator

Color changes 
to CPI less than SPI less than Prorated budget 

exceeded by

Yellow .95 .95 5

Red .8 .8 20
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Microsoft Project Integration
HP Project Management and Microsoft Project can be integrated, allowing you 
to perform tasks such as:

Opening a Microsoft Project file in HP Project Management

Sending a HP Project Management work plan to Microsoft Project

Using Microsoft Project to maintain the work plan while collecting actuals 
through HP Project Management

The Integration with Microsoft Project policy controls the level of integration 
between the two applications. For more detailed discussion of these settings, 
see Project-Level Settings for Integration on page 196.
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Figure 3-8. Microsoft Project Integration policy
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Staffing Profile Assignments
HP Resource Management allows you to attach a staffing profile to a project to 
track resource demand and usage. The Staffing Profile Assignments policy 
allows you to specify a default resource pool to which all resource requests for 
the staffing profile will be routed. For more information on staffing profiles, 
see the HP Resource Management User’s Guide.

Figure 3-9. Staffing Profile Assignments policy

Project Health
The project summary condition indicator that appears on the Project Overview 
page next to the project name is an indicator of the project’s overall health as a 
weighted average of the health indicators for Scheduling, Cost and Earned 
Value Health, and Issue Health.

Figure 3-10. Project health indicators

The Project Health policy controls the relative weights of these indicators. By 
default, each indicator is counted equally. To change the weighting for the 
summary condition calculations, enter a weight value in the appropriate field 
next to the desired indicator.

The Project Health policy also controls whether project managers can override 
the project’s calculated health.

Figure 3-11. Project Health policy
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Issue Health
While a project is in progress, any number of issues may come up that need to 
be submitted and resolved using the project issue request. The real-time status 
of a project in terms of the issues submitted against it is represented by the 
issue health indicator, a colored icon similar to the indicators for Scheduling 
and Cost and Earned Value Health.

Figure 3-12. Project health indicators

The Issue Health policy determines whether issue health is tracked for a 
project, and also controls the following factors in issue health indicator 
calculation:

The weight of each issue priority.

The issue priorities that appear in this policy are determined by the 
validation for the Priority field, which is extensible.

The total weight needed to change issue health indicator color.

As the weight and indicator color change values are pure numerical totals and 
not relative percentages, you may want to plan accordingly for project types 
that are expected to generate large numbers of issues.

Figure 3-13. Issue Health policy
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Task Auditing
HP Project Management can maintain an audit trail of changes to task fields in 
addition to a history for task status, which is always recorded. The Task 
Auditing policy controls which of these fields will be recorded. You must 
enable a field through the Project Fields policy in order to maintain a 
transaction history for it.

Figure 3-14. Task Auditing policy

Project Security
The Project Security policy determines the users who are able to view the 
project and its cost data. 

For viewing the project itself, choose between:

All Users

Only participants (Project Managers, Summary Task Owners, Assigned 
Resources, Assigned Resource Groups, Stakeholders, and Process 
Participants)

For viewing project cost data (budget, financial benefit, cost information), 
choose between:

All Users that can view the project and its tasks
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Project Managers and Stakeholders

Project Managers, Stakeholders, Summary Task Owners and Process 
Participants

Figure 3-15. Project Security policy

Process participants for a project are the users who are included in security 
groups associated with steps in the workflow that governs the project process. 
These security groups, as well as the workflow itself, can be configured to suit 
your business needs. See the HP Project Management Configuration Guide for 
more information.
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4 Creating a Project

In This Chapter:

Overview of Creating a Project
Creating a Project
Using the Project Overview Page
Adjusting Project Settings
Defining Project Participants
Entering Project Details
Creating a Staffing Profile
Creating a Budget
Creating a Work Plan
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Overview of Creating a Project
This chapter describes the process of creating a project. Projects allow 
organizations to define business initiatives with tools including:

A configurable list of project participants

A staffing profile that defines and tracks resource usage for a project

A budget that defines and provides a basis of comparison for the amount of 
money devoted to a project

A work plan that provides a hierarchical structure of tasks that logically 
groups and organizes activities and deliverables 

Using projects, users can define, browse, edit, and manage key aspects of 
complex business initiatives.

The general process of creating a project for project managers is as follows:

1. Log on to PPM Center.

2. Create a project.

When creating a project, you must select a project type. See Creating a 
Project on page 59 for more details.

If you are using HP Portfolio Management, the project may be created for 
you automatically from an existing proposal.

3. Once the project is created, you can perform a number of activities from 
the Project Overview page.

See Using the Project Overview Page on page 60 for more details.

4. Adjust the project’s settings.

Some project settings may be locked down by project policies, which are 
dictated by the project type. See Adjusting Project Settings on page 61 for 
more details.

5. Configure the project’s participants.

You can add to the project’s list of managers and stakeholders. The 
project’s resources and summary task owners are determined by the 
resources assigned in the work plan and the staffing profile attached to the 
project. See Defining Project Participants on page 62 for more details.
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6. Create a staffing profile for the project.

Staffing profiles are a HP Resource Management tool that can be used in 
conjunction with projects to track and manage resource demand. See 
Creating a Staffing Profile on page 63 for more details.

7. Create a budget for the project.

Budgets are a HP Financial Management tool that can be used in 
conjunction with projects to track the cost and available funds for the 
project. See Creating a Budget on page 64 for more details.

8. Create a work plan for the project.

The work plan is the project’s hierarchical structure of tasks that specifies 
task details such as:

Task start and finish dates

Task predecessors, if any

Assigned resources or resource groups

See Creating a Work Plan on page 64 for more details.

9. Once initial planning is complete, set the project and work plan status to 
Active to begin project execution.

Creating a Project
To create a project:

1. Log on to PPM Center.

2. From the menu bar, select Project Management > Projects & Tasks > Create 
a Project.

3. The Create New Project page opens.

4. Fill in all required fields and any optional fields, including Project Type.

The project type contains project policies, which determine project 
settings. Some of these policies may be configured to be non-overridable, 
which lock down their corresponding project settings (see Chapter 3, 
Configuring Project Types, on page 35, for more details on project 
policies). Make sure you are using the desired project type before creating 
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the project. You can only choose from project types to which you have 
been granted access.

5. Click Create.

The project is created and the Project Overview page opens.

Using the Project Overview Page
The Project Overview page displays a wide range of information about a 
particular project, including

Status

Project manager

Any exceptions the project might have triggered

Any issues the project has incurred

Milestones

All of this data and more is presented and arranged through specific sections of 
the Project Overview page.

When a project is first created, the Project Overview page mostly serves as a 
convenient central point from which to create and configure project items such 
as:

Project settings

Project participants

Project details

Staffing profile

Budget

Work plan
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Figure 4-1. Project Overview page: Summary tab

Adjusting Project Settings
Every project contains a number of settings that can be configured by the 
project manager to suit that particular project’s objectives. These settings are 
inherited from the project policies, dictated by the chosen project type.

See Setting Project Policies on page 38 for detailed discussion of each project 
policy.

To view or edit project settings, click Project Settings in the Project Overview 
page.

Project policies can be set to non-overridable, effectively locking down their 
corresponding project settings and preventing you from editing them.
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Defining Project Participants
In general, HP Project Management defines participants in a project according 
to the following groups:

Project managers. Project managers take part in project planning and 
management, overseeing project execution, issue resolution, and budgetary 
concerns.

Stakeholders. Stakeholders are users who do not perform any work on a 
project, but are interested in the project’s status and need to view project 
progress.

Resources. Resources are users who work on tasks as part of a project 
team, but do not have the administrative responsibilities of a project 
manager. Resources view and update their tasks in HP Project 
Management.

Summary Task Owners. Summary task owners are the people named on 
summary tasks who have oversight over that section of the work plan.

The list of resources for a project is automatically defined by the following 
sources:

Resources assigned to tasks in the work plan

Resources specified in the staffing profile for the project

Project managers can specify additional project managers and stakeholders for 
a project.

Figure 4-2. Configure Project Participants page
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Stakeholders can be added individually or by security groups.

To add additional project managers or stakeholders to a project:

1. Create or open a project.

2. On the Project Overview page, click Configure Participants.

The Configure Project Participants page opens.

3. Add additional project managers or stakeholders.

Click Add Project Manager to add a new project manager.

Click Add Stakeholder and select Add User or Add Security Group to 
add new stakeholders.

4. Click Done.

The new project managers or stakeholders have been added.

Entering Project Details
The Project Details tab of the Project Overview page contains fields that hold 
important project information, such as the business unit responsible for the 
project, or the business objectives the project is designed to fulfill. These fields 
drive the overall project process, and can be configured by users with the 
proper level of access, such as a program management office. For more 
information on configuring the Project Details tab fields, as well as the project 
process itself, see the HP Project Management Configuration Guide.

Creating a Staffing Profile
Staffing profiles enable a project manager to track the demand of resources for 
a project, arranged by role or skill. A staffing profile can be created for a 
project to tie it to business functions and facilitate meaningful comparison 
visualizations.

To create a staffing profile for a project, click Create a Staffing Profile in the 
Project Overview page.

For detailed instructions on creating staffing profiles and making use of 
staffing profile functionality, see the HP Resource Management User’s Guide.
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Creating a Budget
Budgets can be used to track financial information for a project, with varying 
levels of data dependency. Once a project budget has been created and the 
project is in progress, actual project costs can be rolled up to the budget for 
comparison purposes. Project cost performance as compared to the budget can 
also be taken into account when calculating project cost health. See Cost and 
Earned Value Health on page 50 for details.

To create a budget for a project, click Create a Budget in the Project Overview 
page. This button will not appear if you do not have the proper access grants or 
level of access to the project or its cost data. For more information on cost data 
security for projects, see Project Security on page 55.

For detailed instructions on creating budgets and making use of budget 
functionality, see the HP Financial Management User’s Guide.

Creating a Work Plan
The work plan is the actual deliverable-oriented grouping of project elements 
that defines and organizes the total work scope of the project. The work plan 
describes both the tasks and milestones, and the scheduled dates for 
completing these items.

You can create a project work plan in any of the following ways:

Create a work plan from scratch. See Chapter 5, Creating a Work Plan, 
on page 65 for more details on creating a work plan.

Create a work plan from a work plan template. See Chapter 9, Using Work 
Plan Templates, on page 173 for more details on this method.

The Work Plan policy in the project settings, which can be inherited from 
project policy, determine which of these options are available. See Work Plan 
on page 40 for more detailed discussion.
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5 Creating a Work Plan

In This Chapter:

Overview of Creating a Work Plan
Adding Tasks and Creating Work Plan Hierarchy

Adding Tasks to the Work Plan
Creating Work Plan Hierarchy
Useful Keyboard Shortcuts in the Schedule View

Creating Milestones
Scheduling the Work Plan

Generating the Schedule
Scheduling Errors
Scheduling Warnings

Displaying Work Plan Information
Level Expand/Collapse
Work Plan Views
Filters
Viewing and Editing Task Details
Viewing Large Work Plans
Resource Usage

Viewing the Work Plan Critical Path
Configuring Tasks
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Overview of Creating a Work Plan
Once you have created a project, you can create its work plan. Project work 
plans allow you to define a business initiative as a hierarchical structure of 
tasks and summary tasks that logically groups, organizes, and schedules 
activities and deliverables.

There are any number of different ways in which you might go about creating a 
work plan from scratch, but one general procedure for creating a new work 
plan in HP Project Management is as follows:

1. On the Project Overview page, click the Create blank work plan link.

2. Add tasks to the blank work plan, filling in the following task aspects first:

Name

Duration

Start or finish date

You can also add predecessors and structure the work plan hierarchy when 
initially adding tasks to the work plan. See Adding Tasks and Creating 
Work Plan Hierarchy on page 67 for more details.

3. Create any desired milestones.

Major milestones can also be added if the project’s settings have been 
configured properly. See Creating Milestones on page 75 for more details.

4. Schedule the project.

See Scheduling the Work Plan on page 76 for more details.

5. Filter the work plan view in different ways to evaluate related information.

You can use different work plan views and filters to evaluate the work plan 
and make subsequent changes to tasks. See Displaying Work Plan 
Information on page 79 for more details.

6. Begin configuring individual tasks, if necessary.

See Configuring Tasks on page 89 for more details.

7. View the work plan’s critical path.

See Viewing the Work Plan Critical Path on page 88 for more details.

You can also create a work plan from a work plan template. See Chapter 9, 
Using Work Plan Templates, on page 173 for more details on this method.
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Adding Tasks and Creating Work Plan Hierarchy
Work plans are created in the Work Plan page. 

For a new project, the Work Plan page is reached by clicking the Create 
blank work plan link.

For an existing project, the Work Plan page is reached by clicking Edit 
Work Plan.

The Work Plan page opens to the Schedule view.

Figure 5-1. Work Plan page: Schedule view

The top-level task is automatically created with the project name.

The Work Plan page opens to the last view you were using when viewing the work 
plan. If the work plan is new, or you have never opened the Work Plan page for this 
project before, the Schedule view opens by default.
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Adding Tasks to the Work Plan
You can add a new task above any existing task in the work plan by selecting 
the task and clicking the Add Task icon, which opens the Add Tasks page. To 
add a task to the work plan:

1. Within the Schedule view, select the empty row at the bottom of the work 
plan and click the Add Task icon.

The Add Tasks page opens, with a new task above the current selection.

2. Click the Add Task Below icon to add a new task below the current 
selection.

You can also add a new task above the current selection by selecting 
the last item in the Add Tasks page and pressing Insert on your 
keyboard.

You can also add a new task below the current section by selecting the 
last item in the Add Tasks page and pressing Enter on your keyboard.

3. Edit the new task’s information.

You should fill in each task’s Name, but in order for HP Project 
Management to schedule the project, you must also provide scheduling 
information. This information can be supplied in the Add Tasks page. 
Click Change at the top of the page to select the combination of scheduling 
information you want to use.

Tasks can also be edited through the Task Details page, which displays 
more detailed information on a task. The Task Details page is accessible 
from the Work Plan page.

a. Select the new task and click the Task Details icon. The Task Details 
page opens.

b. Modify the information under each tab in the Task Details page as 
necessary (for details, see Chapter 6, Configuring Tasks, on page 91).

4. Configure the task hierarchy, if desired.

You can structure the newly-added tasks into a hierarchy of summary tasks 
and subordinates using the Indent and Outdent icons at the top of the Add 
Tasks page. See Useful Keyboard Shortcuts in the Schedule View 
on page 74 for keyboard shortcuts that can help you save time.

5. Add the new tasks to the work plan.

To add the tasks to the work plan, click Done.
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Creating Work Plan Hierarchy
HP Project Management allows users to add and structure tasks in any order, 
from either the Add Tasks page or the Work Plan page. Once tasks have been 
added, you may find that you need to rearrange them later. The Work Plan 
page also allows you to arrange and group tasks in a hierarchy. 

Figure 5-2. Work Plan page

To move an item up or down in the hierarchy:

1. Select the task or collapsed summary task.

2. Click the Cut icon.

You can also simply copy a task using the Copy icon. Copied tasks can be 
pasted several times.

3. Select the task below your target area in the work plan hierarchy.

4. Click Paste icon.

The cut item is placed in the work plan above the selected task.

Large work plans may split up work plan information into pages. You can 
cut tasks from one page of the work plan and paste them into another. See 
Viewing Large Work Plans on page 86 for more information.

Changes made to the work plan in the Work Plan page are immediately saved.
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To indent an item:

1. Select the task or collapsed summary task.

2. Click the Indent icon.

The selected task or summary task moves one level deeper in the hierarchy.

If the item immediately above the selected item is a task, that task is 
converted to a summary task.

Acting on a summary task acts on its children. Indenting a summary 
task brings its children one level down in the hierarchy as well.

To outdent an item:

1. Select the task or collapsed summary task.

2. Click the Outdent icon.

The selected task or summary task moves out one level in the hierarchy.

Acting on a summary task acts on its children. Outdenting a summary 
task brings its children one level up in the hierarchy as well.

If the selected item was a child of a summary task, it becomes either a 
task or summary task on the same level as its former parent.

If the selected item was a summary task’s only child, that summary task 
is converted into a task.

If the selected item was a task with other tasks of the same level 
beneath it, those tasks are converted to children of the selected item, 
which is now a summary task.

You can act on multiple tasks simultaneously:

Use Shift + click to highlight a set of contiguous rows and act on all of 
them.

Use Ctrl + click to make multiple non-contiguous selections and act on all 
of them.

If the selected item is the first child of a summary task, you will not be able to indent it.

Tasks with actuals data cannot become summary tasks. This includes tasks that 
contain actuals from HP Time Management, or tasks that are referenced by time 
sheets.
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Setting Up Predecessors

HP Project Management allows you to create relationships between a task and 
other tasks in the current work plan, tasks in other work plans, or requests in 
HP Demand Management. These predecessor relationships are used by the 
scheduler to determine when the task will be scheduled.

For example: Manager Bob has a Training work plan for a new software 
module being installed on his group’s computers. In order for his training 
activities to get started, the Software Upgrade project headed by Manager 
Steve must be finished first. Bob can create a finish-start predecessor 
relationship between the most relevant task in the Software Upgrade project 
and his own Training tasks.

These predecessor relationships are controlled from the Schedule tab of the 
Task Details page.

Figure 5-3. Task Details page: Schedule tab

The types of predecessor relationships available are described in Table 5-1.
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Table 5-1. Possible predecessor relationships to a project or task

Predecessor 
Type Description Possible Relationships

Summary Task 
or Task

A task in the 
current work 
plan

Finish-Start. The successor can start once 
its predecessor has completed.
Start-Finish. The successor cannot finish 
until the predecessor starts. Cannot be set 
for summary tasks.
Finish-Finish. The task can start anytime, 
but the successor will not be marked as 
complete until its predecessor finishes. 
Cannot be set for summary tasks.
Start-Start. The successor cannot start until 
the predecessor has started.

You can also define lag or lead time for 
predecessor relationships by entering a 
positive or negative number in the Lag (Days) 
field, if desired.
When adding a summary task as a 
predecessor, only relationships of the 
Finish-Start or Finish-Finish type are allowed.
When adding a predecessor to a summary 
task, only relationships of the Finish-Start or 
Start-Start type are allowed.

External Task
A task from a 
separate 
project

Same as internal task.

Request
A request in 
HP Demand 
Management

Request relationships are managed from the 
References tab of the Task Details page.

Related. Informational relationship only: No 
actual predecessor relationship exists. This 
is the only relationship allowed for summary 
tasks.
Successor (Blocked). No action is allowed 
on the request until the task is completed.
Predecessor (Blocking). No action is 
allowed on the task until the request is 
completed.
FF Predecessor (Finish Finish 
Predecessor). The task can start anytime, 
but cannot be marked as finished until the 
request is completed.
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Setting Internal Predecessors

To set an internal predecessor task for a task:

1. Open the Task Details page of the task.

2. Click the Schedule tab.

3. Click Add a predecessor and select Add task by name.

An auto-complete window opens listing all tasks in alphabetical order. You 
can filter the list using the Task starts with filter field.

You can also add a predecessor directly by sequence number, if you know 
the predecessor’s sequence number in the work plan.

4. Select a task.

The predecessor task is now listed in the Schedule tab of the Task Details 
page.

5. Select a relationship from the Relationship field.

6. Type a value in the Lag (Days) field, if desired.

This field allows you to specify a number of days to delay starting on a 
given task based on its predecessor’s finish. Negative numbers can be used, 
which work as lead time.

7. Click Save.

Setting an External Predecessor Task

To set an external predecessor task for a task:

1. Open the Task Details page of the task.

2. Click the Schedule tab.

3. Click Add a predecessor and select Add External Task.

An auto-complete window opens, allowing you to search for external tasks 
to add. You can filter the list using the Task starts with filter field.

4. Select a task.

The predecessor task is now listed in the Schedule tab of the Task Details 
page.

5. Select a relationship from the Relationship field.
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6. Type a value in the Lag (Days) field, if desired.

This field allows you to specify a number of days to delay starting on a 
given task based on its predecessor’s finish.

7. Click Save.

Setting a Request as a Predecessor

You can add an existing request as a predecessor for a task through the 
References tab in the Task Details page. See Attaching Existing Requests 
on page 105 for more detailed information. You can also add a new request as 
a predecessor for a task. See Attaching New Requests on page 106 for more 
detailed information.

Useful Keyboard Shortcuts in the Schedule View
Tasks and summary tasks within the Schedule view can be manipulated from 
the keyboard as well as the icons in the Schedule view. Table 5-2 lists all 
available keyboard shortcuts.

Table 5-2. Keyboard shortcuts for defining work plans

Keystroke Action

Insert Inserts a task into the hierarchy above the current row in 
the Add Task page.

Shift + Alt + Left 
Arrow Outdents a task in the hierarchy.

Shift + Alt + Right 
Arrow Indents a task in the hierarchy.

Enter Opens the Task Details page.

Ctrl + C Copies the selected task.

Ctrl + V Pastes a task or tasks (must be on the work plan’s last 
line).
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Creating Milestones
Milestones are used to mark significant events in the execution of a project, 
often the completion of a deliverable or arrival of a deadline. 

As markers of other progress, milestones generally do not have duration or 
effort, although they can be configured to have both. Project managers can 
indicate that the milestone should automatically complete once its 
predecessors are complete, providing a means of reporting project progress 
without project manager intervention. In some cases, however, project 
managers may want control over whether the milestone has completed, 
regardless of whether the work leading up to it indicates it should be.

A work plan may contain many milestones that help the project manager gauge 
execution progress. Often, however, there is a smaller set of standard 
milestones that are used and reported on all projects within an organization, 
such as phase-completion milestones. If the project has been configured to 
allow them, the project manager can identify such milestones as major 
milestones which will be displayed on the Project Overview page, allowing for 
uniform high-level visibility while still allowing the project manager to define 
as many milestones as required to manage the detailed plan. See Project Fields 
on page 38 for information about enabling major milestones.

To create a milestone:

1. Select a task.

2. Click the Task Details icon.

The Task Details page opens.

3. Select the Mark task as milestone checkbox.

If you want the milestone to mark itself as complete automatically when all 
predecessors are complete, select the Milestone automatically completes 
checkbox. This is only available for milestones whose duration is 0.

4. Modify any other information under each tab in the Task Details page as 
desired (for details, see Editing Task Information on page 95).

5. Click Save.

A task will be automatically converted to a milestone if its duration is 0.
Once a milestone has been created, its duration is automatically set to 0, but you can 
alter its duration if necessary.
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Scheduling the Work Plan
HP Project Management generates schedules for work plans, based on the 
configurations set in the project’s Scheduling policy and the options provided 
in the Schedule Work Plan dialog box.

Generating the Schedule
When the work plan is scheduled, the entire work plan is considered, and 
changes are immediately saved. If you want to reschedule discrete sections of 
the work plan, you can place constraints on the relevant summary tasks to 
accomplish the move.

To generate the schedule for a work plan:

1. Click the Schedule Project icon.

The Schedule Work Plan dialog box opens.

2. In Schedule from date, specify a date from which to schedule the work 
plan.

This is usually set in the Scheduling policy individually for each project 
and generally does not change unless the entire project needs to shift dates. 
If you are collecting actuals in your work plan, changing the Schedule from 
date field and rescheduling the work plan can push remaining work into the 
future.

3. If desired, type a Critical Path Threshold.

For more details on the purpose of the critical path threshold, see Critical 
Path Threshold on page 43.

4. Click Schedule.
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Scheduling Errors
It is possible for certain combinations of input to cause a schedule to be 
unworkable. If any of these errors are encountered, the schedule will not be 
created. Table 5-3 describes scheduling errors, their causes, and possible 
solutions.

Scheduling Warnings
It is possible that because of the specifics of the work plan, the scheduler 
cannot produce a consistent schedule. A schedule will be produced, but 
schedule warnings are generated that highlight the structural inconsistencies in 
the work plan. The Schedule Warning Rules enabled in the Schedule policy in 
the project’s settings identify these problems. Warnings appear when the 
scheduler runs, and are evaluated when the work plan is saved. Warnings are 
also saved in the Warnings tab of each affected task’s Task Details page, for 
later perusal. Table 5-4 describes scheduling warnings, their causes, and 
possible solutions.

If scheduling errors occur, no schedule will be generated and a list of errors will 
appear. Take note of each error and its cause, and make the necessary adjustments 
within the work plan. See Scheduling Errors for more details.
If scheduling warnings occur, a schedule will be generated and a list of warnings will 
appear. Take note of each warning, as they can be important to the initiative’s 
success. See Scheduling Warnings for more details.

Table 5-3. Scheduling errors, causes, and possible solutions

Scheduling 
Error Cause Possible Solution

Circular 
dependency

The predecessors of a set of projects 
or tasks contains a cycle. This cannot 
be scheduled.
HP Project Management detects 
circular dependencies while creating or 
editing the work plan.

Break the cycle by 
removing or changing 
a predecessor. 

No tasks to be 
scheduled

The work plan is complete or 
cancelled, so there are no tasks to be 
scheduled.

If tasks are missing, 
add them and then 
schedule.
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Table 5-4. Scheduling warnings, causes, and possible solutions

Scheduling 
Warning Cause Possible Solution

Project Date 
Conflicts

This warning occurs when the work 
plan dates extend beyond the project's 
Planned Start Period or Planned Finish 
Period. It also occurs when the 
constraint defined on the task is outside 
the project's Planned Start Period or 
Planned Finish Period.

Bring the plan within the project’s dates 
by adjusting dependencies, duration, 
resources, or any combination thereof, 
and rescheduling.
In some cases, resolution may involve 
expanding project-level dates, which 
should be coordinated with the project 
budget and staffing profile.

Dependency 
Conflicts

These warnings occur when a 
predecessor dependency defined for 
the task could not be honored because 
other constraints or task information 
prevents it.
For example, a task may be expected to 
start on October 10th based on its 
predecessor relationships, but might 
have a Start No Later Than constraint 
defined for October 1st. The task 
cannot meet both requirements.

Rework the plan to remove the conflicts.

Constraint 
Inheritance 
Conflicts

These warnings occur when there is a 
direct conflict between the constraints 
defined for a task and its parents, such 
that only one can be satisfied. Both 
related tasks are marked.

Rework the plan to remove the conflicts.
If both constraints are valid, you may 
need to file a project issue. See Logging 
Issues on page 140 for more 
information.

Resources 
Could Not Be 
Scheduled

The scheduler could not identify 
sufficient available working days for the 
assigned resources to schedule the 
task. This warning is evaluated only 
when the scheduler runs.

This usually occurs when the scheduler 
attempts to schedule a resource after 
the resource’s end date or before the 
resource’s start date. Check resource 
information, and if necessary, change 
the task resource or change task 
dependencies so that it can occur during 
the right dates.

Task 
Constraint 
Could Not Be 
Met

This warning occurs when the 
constraint defined on the task could not 
be honored because other conflicting 
information takes precedence.

This usually occurs when using actuals 
during scheduling and the task’s actual 
start date conflicts with a constraint 
defined for the task. This may not 
require explicit resolution.
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Displaying Work Plan Information
HP Project Management includes several different ways to view work plan 
data, allowing you to focus on the specific task at hand.

Level Expand/Collapse allows you to immediately expand or collapse the 
work plan view to a specific hierarchy level, so you can quickly assess the 
plan without being overloaded with plan details.

Work Plan Views provide you with different ways of looking at the work 
plan based on the tasks you need to perform or the information you need 
from the plan.

Filters allow you to filter data within a particular work plan view for a 
subset of information, enabling you to efficiently focus on the tasks that 
need your attention.

The Gantt View allows you to visualize tasks and their dependencies in a 
graphical format enhanced with color-coding and configurable labeling.

In general, HP Project Management keeps track of column width and position 
in each work plan view for you, so when you log out and return to a project 
later, your column layout is the same as when you left it.

Level Expand/Collapse
Click Expand to: Level to expand or collapse your view of the work plan and its 
summary tasks to a specific hierarchy level from 2 to 7.

Level 2 displays only tasks and summary tasks directly below the root level 
of the work plan, collapsing everything below.

Level 7 displays tasks and summary tasks down to the seventh hierarchy 
level of the work plan, collapsing everything below.

Work Plan Views
HP Project Management includes several work plan views that give visibility 
into different categories of work plan information. These views are accessible 
from the Change View button menu at the top of the Work Plan page.

Schedule View

The Schedule view is the default view on the Work Plan page. Use this view to 
adjust task hierarchy in the work plan view schedule-related information.
Creating a Work Plan 79



The Schedule view displays the following task fields as columns:

Task Status

Scheduled Duration

Scheduled Start

Scheduled Finish

Scheduled Effort

Predecessors

Resources

Role

Activity

Unassigned Effort

Actuals View

The Actuals view focuses on information collected about the progress of the 
work plan, and displays the following task fields as columns (some columns 
only appear if selected in the Project Fields or Cost and Effort policy):

Task Status

Actual Effort

Percent Complete

Estimated Remaining Effort

Actual Start

Actual Finish

Actual Duration

Estimated Finish

Resources

Predecessors

Actuals As Of (date actuals were last updated)

All values for fields that track duration are in days, while all values for fields that track 
effort are in hours.
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Figure 5-4. Work Plan page: Actuals view

Costing View

The Costing view displays the costing data for a project, if HP Financial 
Management has been enabled in the Cost and Effort policy. Table 5-5 
describes the task fields displayed in the Costing view as columns. This view is 
only available to users who have viewing access to project cost data.

Table 5-5. Available columns in the Costing work plan view (page 1 of 2)

Column Name Description

Cost Health The cost health of the task.

Planned Labor

The planned labor cost for the task.
Calculated as:
Scheduled effort * applicable cost rate
Applicable cost rates include:

Resource (if resource has no cost rate, resource region, 
role, and skill are considered next)
Task role
Task skill set

Planned Non-Labor The planned non-labor cost for the task. Manually entered.

Planned Cost The sum of planned labor and non-labor costs.

Actual Labor
The actual labor cost for the task.
Calculations are the same as for planned labor, except with 
actual effort substituted for scheduled effort.

Actual Non-Labor The actual non-labor cost for the task. Manually entered.
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Figure 5-5. Work Plan page: Costing view

You can control the display of certain columns by adjusting the appropriate 
settings in the project’s Cost and Effort policy. See Adjusting Project Settings 
on page 61 for details.

Earned Value View

The Earned Value view displays earned value (EV) analysis data for the project 
by displaying the following task fields as columns:

Planned Value

Earned Value

Cost Variance

Actual Cost The sum of actual labor and non-labor costs.

Planned Capital 
Expense

The planned cost for a task associated with an activity 
marked as capitalized.

Planned Operating 
Expense

The planned cost for a task associated with an activity 
marked as operating.

Actual Capital 
Expense

The actual cost for a task associated with an activity 
marked as capitalized.

Actual Operating 
Expense

The actual cost for a task associated with an activity 
marked as operating.

Activity The activity associated with a task.

Table 5-5. Available columns in the Costing work plan view (page 2 of 2)

Column Name Description
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Schedule Variance

CPI

SPI

Actual Cost

This view is only available to users who have viewing access to project cost 
data, and is only useful if you have taken at least one baseline of the project. 
For more details on project baselines, see Working with Baselines on page 146.

Gantt View

The Gantt view includes a Gantt chart, a convenient graphic display of 
schedule-related information, including task length and timing. Summary tasks 
can be color-coded to indicate health. Colors and patterns serve to provide 
information on completion status. Optional task labels can provide additional 
details (see Changing Gantt View Display)

You can also change the time scale for the chart, as well as fit the entire project 
into the current Gantt view. Figure 5-6 shows a typical project Gantt chart.

Figure 5-6. Work Plan page: Gantt view

Changing Gantt View Display

You can make adjustments to the Gantt chart display by clicking Actions > 
Configure Display on the Work Plan page. The Display Options dialog box 
contains settings for the Gantt chart’s indicators and text labels.
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Printing View

The Printing view provides the user with a view in which all of the fields in all 
the views are combined. The columns are arranged by view in the following 
order:

Schedule

Actuals

Cost

Earned Value

Use this view to configure the order and sizing of columns for generating PDF 
printouts that include columns that cross the different views. For more 
information on exporting the work plan to a PDF file, see Exporting to PDF 
Files on page 148. For optimal system performance, use the other work plan 
views for targeted tasks.

Filters
HP Project Management includes filters for each work plan view that allow 
you to filter the work plan for a certain set of tasks, enabling you to quickly 
focus on the data most relevant to your activity. Summary tasks that own the 
tasks selected by the filter are always displayed to provide context. Table 5-6 
lists the filters for each work plan view.

Table 5-6. Work plan view filters (page 1 of 2)

Filter Name Description

Schedule and Tracking views

Tasks in progress Only shows tasks in the work plan that are in 
progress.

Tasks complete Only shows tasks in the work plan that are 
complete.

Tasks overdue
Only shows tasks in the work plan that have 
passed their scheduled finish date but are not 
yet complete.

Tasks that are 
unassigned

Only shows tasks in the work plan that have no 
resource assigned to them.

Tasks that are 
milestones

Only shows tasks in the work plan that are 
milestones.
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Viewing and Editing Task Details
Task fields are not editable from the Work Plan page. Instead, individual tasks 
are edited from the Task Details page, making small, discrete changes possible 
instead of mass change on a wider scale. For more details on editing tasks, 
including navigating between tasks, see Editing Task Information on page 95.

Tasks on the critical path Only shows tasks in the work plan that are on 
the critical path.

Tasks with external 
predecessors

Only shows tasks in the work plan that have 
external predecessors.

Tasks with contributions

Only shows tasks in the work plan that have ad 
time logged against them in HP Time 
Management by non-assigned resources. This 
can help you identify unexpected time logged 
against your project.

Tasks with constraints Only shows tasks in the work plan that have 
constraints.

Tasks by resource Only shows tasks in the work plan that are 
assigned to a specified resource(s).

Tasks by role Only shows tasks in the work plan that are 
assigned to a specified role.

Tasks starting in Only shows tasks in the work plan scheduled to 
start within a specified date range.

Tasks completing in Only shows tasks in the work plan scheduled to 
complete within a specified date range.

Tasks occurring in Only shows tasks in the work plan scheduled to 
occur within a specified date range.

Tasks with actuals since

Only shows tasks that have had actuals 
updated after a specified date.
For example, this is useful for finding tasks 
updated during the current week.

Table 5-6. Work plan view filters (page 2 of 2)

Filter Name Description
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Viewing Large Work Plans
HP Project Management allows you to control the number of tasks in your 
work plan that can be displayed at one time, allowing you to efficiently 
manage your work plan regardless of whether you are working on a fast local 
LAN or a distributed network. The set of tasks displayed at a time is referred to 
as a “page.” You can navigate between pages in a large work plan in the 
following ways:

Click Prev and Next to navigate between adjacent pages.

Type the sequence number of a specific task in Seq # and click Go to 
navigate to that task. The task will display at the top of the page. This 
allows you to reorient the page to display the data in which you are 
interested.

HP Project Management shows you pages of displayed tasks. The 
collapsed children of summary tasks are not counted.

Adjusting Personal Page Size Preferences

You can adjust the number of rows per work plan page in the Project Work 
Plan Preferences section of the Edit My Profile page, accessed by selecting 
Administration > Edit My Profile from the menu bar.

Figure 5-7. Edit My Profile page
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Select an option or type your own value for the number of tasks per page you 
wish to see and click Done. You can change this setting at any time, based on 
the connection speed at your location.

Resource Usage
The Resource Usage page displays assignment-level load data grouped by 
resource. Open the Resource Usage page by clicking Actions > Resource 
Usage on the Work Plan page. Fields in this page are not directly editable, 
though tasks can be opened and modified from this page or the Work Plan 
page. The Resource Usage page is optimized for use with the staffing profile 
for the project, which determines work plan capacity.

Other features of the Resource Usage page include the following:

If an over-allocation has taken place, an indicator appears to the left of the 
resource name.

The pre-set and maximum page size values are determined by your PPM Center 
administrator. See the HP Project Management Configuration Guide or consult your 
system administrator for more details on work plan page size controls and their 
adjustment.

Table 5-7. Available columns in the Resource Usage work plan view

Column 
Name Description

(Indicator 
column)

Indicates whether the resource has been over-allocated on any of 
the days displayed.

Name The name of the resource.

Role

Indicates the role intended to be utilized.
The role appearing next to the resource name is specified in 
the project staffing profile, if one exists.
The role appearing next to the task name is specified in the 
work plan.

Effort (Load)
The total amount of effort assigned to the resource. This column is 
broken down into sub-columns that track scheduled effort, actual 
effort, and the allocation for the resource.

Start The start date for the assigned task.

Finish The end date for the assigned task.

Status The status of the assigned task.
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The Resource Usage page displays the amount of resource load coming 
from external sources. Clicking the External Load link below a resource 
name opens their resource load breakdown.

The Resource Usage page includes a table displaying the resource load 
details for the project, which highlights over-assignments in red. The table 
can be set to view a specific range of dates and broken down by different 
period types. To change the date range and time breakdown of the table, 
enter the desired values in the View data from and grouped by fields and 
click Apply.

Viewing the Work Plan Critical Path
A work plan’s critical path is composed of all of the tasks in a work plan that 
determine its duration. In HP Project Management, the critical path of a work 
plan can be highlighted in the Schedule view’s Gantt chart. Tasks that are part 
of the critical path are outlined in orange. You can also view the work plan’s 
critical path using one of the Filters.

Figure 5-8. Work Plan page: Gantt view displaying critical path

To see a work plan’s critical path:

1. On the Work Plan page, click Actions > Configure Display.

The Display Options dialog box opens.

2. Select the Mark Tasks on Critical Path checkbox.

3. Click Done.

4. The Gantt chart displays the work plan’s critical path in orange.
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Configuring Tasks
Once the initial work plan is created, you can configure individual tasks as 
required to refine your plan. Activities involved in refining your plan might 
include:

Finding and assigning resources to tasks

Adjusting task effort estimates or duration as additional information 
becomes available

Configuring email notifications to ensure that tasks needing attention are 
made known to the right people

Adjusting task dependencies as more becomes known about task details

Rescheduling the plan

Reviewing resource load to ensure resources are utilized within the bounds 
of their staffing profile assignments

Exporting work plan view for off-line discussion, printing, or publication

For detailed discussion of these task configuration items, see Chapter 6, 
Configuring Tasks, on page 91, and Chapter 7, Managing a Project, 
on page 111.
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6 Configuring Tasks

In This Chapter:

Task Elements
Notifications
References
Activities
Task Statuses

Adding Tasks to Work Plans
Creating a Milestone

Editing Task Information
Assigning Resources

Assigning Resources in the Add Tasks Page
Assigning Resources in the Task Details Page
Managing Scheduled Effort

Assigning Skills or Roles
Configuring Task Predecessors
Setting Scheduling Constraints
Adding Notes
Setting Up Notifications
Entering Cost Data
Attaching References to Tasks

Attaching Existing Requests
Attaching New Requests
Attaching Existing Packages
Attaching New Packages
Attaching Tasks
Attaching Releases
Attaching Documents
Attaching URLs

Changing the Task Status
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Task Elements
Work plans are repositories of information consisting of tasks, summary tasks, 
notes, and references. These elements model the work required to achieve 
specific business initiatives within an organization. Work plans are not static 
entities. They gather additional information and are modified as their tasks 
move through to completion. 

Tasks are the components of a work plan that must be completed in order for 
the work plan to complete successfully. Project managers gather information 
from tasks and make appropriate changes to the project during the project 
process. This means that tasks must be configured to deliver the kinds of 
specific information that project managers need. For example, project 
managers may need to be notified when tasks are completed or their statuses 
change.

Tasks also need to be modified during the project execution, such as extending 
task schedules or assigning additional resources to a task to make a deadline. 
Team members must update their individual statuses as they complete assigned 
tasks. 

Notifications
Project managers can set up notifications for tasks within a work plan. Email 
messages can be sent to appropriate team members whenever a specific event 
occurs on a task. This would include such events as:

The completion of a milestone.

The triggering of an exception rule by a task.

The approach of a task’s start date.

References
Tasks can include additional references to other entities or points of 
information, allowing easy access and visibility to data related to the current 
task. Summary information for references is viewed as part of the task. 

There are several reference types defined for tasks: requests, packages, 
projects, releases, attachments, and URLs.
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Activities
Tasks can be characterized by the type of activity involved in accomplishing 
the task. For example, certain tasks could be categorized as design activity, 
while other tasks could be characterized as testing activity. Though they can be 
used for simple categorization, activities are usually used to identify 
capitalizable costs for SOP 98-1 compliance. For more information on 
activities and their use, see the HP Financial Management User’s Guide.

Task Statuses
On the Work Plan page, the task status is displayed in the Status column of the 
Schedule view. The available statuses for a task are defined in Table 6-1. 
Table 6-2 describes statuses for summary tasks.

Table 6-1. Task status definitions

Task Status Definition

Pending Predecessor A task that is holding for one or more predecessors to 
be completed.

Ready A task that is ready to be worked on by its resource.

In Progress A task that is moving through the actions necessary for 
its completion.

Completed A task that has been finished.

Cancelled
A task that is not complete and will not be worked on, 
as it is no longer required for the completion of the 
project.

Complete (Pending 
Predecessor)

A task that has been finished but requires its 
predecessor to be complete before being truly done.

Table 6-2. Summary task status definitions (page 1 of 2)

Task Status Definition

In Planning This section of the work plan is still being developed 
and is not ready to execute.

Active
This section of the plan is available to execute. 
Resources cannot report actuals against a work plan 
until it becomes Active.
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Adding Tasks to Work Plans
Tasks can be added to a work plan individually or in a pre-sequenced group, as 
defined in a work plan template. 

Tasks can also be quickly and easily organized in a hierarchical fashion. See 
Adding Tasks and Creating Work Plan Hierarchy on page 67 for more 
information. 

Creating a Milestone
Tasks can be converted into milestones.

To create a milestone from a task:

1. Double-click the task to be edited.

The Task Details page opens.

On Hold

This section of the plan has been put on hold. This 
may be because re-planning was needed, a future 
phase is still being planned, or work has been 
temporarily suspended.

Completed
This section of the plan has completed execution. All 
of the tasks in this section are either completed or 
cancelled.

Cancelled
This section of the plan has been cancelled and will 
never complete. All of the tasks in this section are 
cancelled.

Table 6-2. Summary task status definitions (page 2 of 2)

Task Status Definition

Depending on their defined level of responsibility in a project, users can only be able 
to change tasks between certain statuses. 
For example, project managers can change a task from Ready to In Progress to 
Cancelled, or from Cancelled back to Ready. Project participants cannot change the 
task status directly. The task status is derived based on the actuals reported by 
resources.
Available task statuses can also depend on the status of the work plan.
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2. Select the Mark task as milestone checkbox.

This automatically changes the task’s duration to 0, which you can edit 
manually if you want its duration to be greater.

If you want the milestone to mark itself as complete automatically when all 
predecessors are complete, select the Milestone automatically completes 
checkbox. This option is unavailable for milestones with duration other 
than 0.

3. Modify any other information under each tab in the Task Details page as 
desired (for details, see Editing Task Information).

4. Click Save.

Editing Task Information
Task information is edited in the Task Details page, which can be reached from 
the Work Plan page or the Resource Usage page. HP Project Management 
allows you to navigate from task to task without needing to return to the Work 
Plan page.

Figure 6-1. Task Details page

A task will be automatically converted to a milestone if its duration is 0.
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Click Prev and Next on the Task Details page to navigate from task to task, as 
they are displayed on the Work Plan page.

Task-to-task navigation takes into account the expand/collapse state of the 
Work Plan page. If a summary task is collapsed on the Work Plan page, 
clicking Next will not navigate through the summary task’s children.

Task-to-task navigation also takes into account any Filters that have been 
applied to the Work Plan page. If a filter has been applied to the Work Plan 
page, clicking Next navigates to the next task in the filtered set.

Summary tasks may be shown on the Work Plan page in grey italics to 
provide context to a filtered set. These grey tasks are skipped when 
navigating from task to task using the Prev and Next buttons in the Task 
Details page.

To edit task information in the Task Details page:

1. Open the Work Plan page for the project you are editing.

2. Double-click the task to be edited.

The Task Details page opens.

3. Make whatever changes are necessary in the Task Details page.

4. Click Save.

Assigning Resources
Project managers can assign resources to new tasks being added in the Add 
Tasks page. Resources can be assigned to existing tasks using the Task Details 
page. All resources must satisfy one of the following conditions in order to be 
assigned to a task:

The resource is named on the staffing profile attached to the project

The resource belongs to a resource pool managed by the project manager

Other resources should be requested from other resource pools using standard 
staffing profile functionality. See the HP Resource Management User’s Guide 
for more detailed information on staffing profiles and their interaction with 
resource pools.
96 Chapter 6



Assigning Resources in the Add Tasks Page
Resources can be assigned for new tasks in the Add Tasks page directly by 
clicking the Resource icon.

To assign resources to a new task:

1. Create a new task in the Add Tasks page.

2. Click the Resource icon to assign a resource.

3. Click Done.

Assigning Resources in the Task Details Page
Resources can be assigned to existing tasks using the Task Details page.

To assign resources to existing tasks:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the Resources tab.

3. Click Add Resource to assign a resource, or the Resource Finder icon to 
search for and assign an appropriate resource.

See the HP Resource Management User’s Guide for more detailed 
information on using the Resource Finder.

4. Click Save.

Multiple resources can be assigned to tasks. Once multiple resources have 
been assigned, their individual effort hours or booked skill can be adjusted 
at any time.

Managing Scheduled Effort
Scheduled effort for a task can be calculated automatically by Project 
Management or entered manually. By default, the method of scheduled effort 
calculation is set at the project level by the Cost and Effort policy, but 
depending on those settings, it can be changed on a task-by-task basis.

If you choose to Automatically calculate Scheduled Effort, the system 
assumes that each resource will work full-time on the task. The scheduled 
effort is calculated by multiplying the resource’s number of work hours per 
day by the task’s duration. Changing the task’s duration changes the 
resource’s scheduled effort automatically.
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If you choose to Manually enter Scheduled Effort per task assignment, you 
can manually enter a scheduled effort value for each resource assigned to 
the task. This could be useful for cases where resources are not expected to 
work full-time on tasks, and especially for projects where detailed effort 
estimates are required in the planning stages. Changing the task’s duration 
does not change effort information. Effort for new tasks is set at 0.

Any remaining unassigned effort for each task is collected by an 
Unassigned Effort field. This allows the remaining effort on a task to be 
assigned to resources incrementally as they are identified.

Assigning Skills or Roles
When creating a work plan, you can assign a skill set or role to any task 
without specifying a resource. This allows you to create a work plan that 
identifies the roles or skills needed to complete its tasks without necessarily 
pinpointing the specific resources that will ultimately do the work. 
Additionally, capturing roles or skills required to complete tasks provides a 
more detailed estimate of the project cost; this helps make sure the budget is 
correct and the right resources are allocated.

To assign a role to an existing task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the Resources tab.

3. Select an Assigned Role for the task.

4. Click Save.

To assign a skill to an existing task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the Resources tab.

3. Click Add Skill to select a skill.

4. When the skill is added, select a proficiency from the Ideally column.

5. Click Save.

If you assign a resource to a task, the Assigned Role field will automatically populate 
with the resource’s primary role, if one has been defined.
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Configuring Task Predecessors
Task predecessors are configured from the Task Details page. A predecessor is 
a task that has a defined relationship between its start or finish date, and the 
start or finish dates of the task that is dependent on it.

See Setting Up Predecessors on page 71 for more detailed information on 
setting task predecessors.

Although tasks can only have predecessor relationships to other tasks, a 
task may have references defined that identify relationships to other 
entities (for example, an informational reference to a package used to roll 
out code developed as part of a task’s completion). See Attaching 
References to Tasks on page 105 for more information on how to assign 
relationships between tasks and references.

Setting Scheduling Constraints
In addition to its relationship with other tasks in the work plan, a task may have 
other date-related constraints. For example, a project manager may want to 
specify that a task must start on a particular date, or finish no later than a 
particular date. These constraints provide valuable information about tasks, 
and are also used by Project Management to generate the work plan schedule.

Scheduling constraints are set in the Schedule tab of the Task Details page. 
Constraints can be defined for summary tasks or their children. If a constraint 
is defined for a summary task, it also applies to all of its child tasks. Table 6-3 
describes the constraints available for tasks and summary tasks.
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Table 6-3. Scheduling constraints for tasks and summary tasks

Constraint Description
Summary 
Task 
Availability

As Soon As Possible

The task will be scheduled as early as 
the work plan structure and 
dependencies allow.
This is inferred if no constraint is 
defined.

Y

As Late As Possible
The task will be scheduled as late as the 
work plan structure and dependencies 
allow.

N

Start No Earlier Than The task cannot start before the date 
specified. Y

Start No Later Than The task should start on or before the 
date specified. N

Finish No Later Than The task must finish by the date 
specified. Y

Must Start On The task must start on the date 
specified. N

Finish No Earlier Than The task should not finish before the 
date specified. N

Must Finish On The task must finish on the date 
specified. N
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Figure 6-2. Task Details page: Schedule tab

To set a task’s scheduling constraints:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the Schedule tab in the Task Details page.

3. Under Scheduling Constraints, select the type of constraint you want to use 
from the Constraint Type field.

4. Type a date in the Constraint Date field.

5. Click Save.
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Adding Notes
Users can enter free-form text in the Notes tab of the Task Details page. Saved 
entries are marked with a timestamp.

Figure 6-3. Task Details page: Notes tab

To add notes to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the Notes tab.

3. Type any notes into the Notes field.

4. Click Save.

The Notes tab can contain up to 32K of information per work plan. 
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Setting Up Notifications
You can set up email notifications in the Task Details page to be sent to users 
when certain events occur during project execution. Notifications that are 
defined for a summary task apply automatically to all of the summary task’s 
children, though notifications that have been defined directly for a child task 
override any notifications set by the parent. Table 6-4 describes the possible 
notifications.

Figure 6-4. Task Details page: Notifications tab
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To set up a notification for a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the Notifications tab. 

3. Select the checkboxes next to the appropriate notifications.

4. Click Save.

Entering Cost Data
If Project Management’s Financial Management capability has been enabled 
for this project, you can track and enter actual cost data in the Cost tab of the 
Task Details page. See the HP Financial Management User’s Guide for more 
detailed information.

Table 6-4. Possible email notifications for tasks

Notification Description

Notify resources before 
their task(s) begin

Notifies a resource before their tasks begin. You 
can set the number of days in advance of the 
start date from which to send the notification.

Notify resources if their 
task(s) are running late

Notifies a resource that their tasks are running 
late. You can specify the frequency with which 
this notification is sent.

Notify if task(s) are 
running late

Notifies a wider range of users of tasks in the 
work plan that are running late. You can specify:

The number of late days required to trigger the 
notification
The frequency with which the notification is 
sent
Sets of users to send the notification to

Notify when a milestone 
is reached

Notifies a set of users when the task has been 
reached, if it is a milestone. You can specify sets 
of users to send the notification to.

Notify when an 
exception occurs

Notifies a set of users when the task has 
triggered an exception. You can specify sets of 
users to send the notification to.
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Attaching References to Tasks
HP Project Management features a number of methods for capturing additional 
information, or references, related to your projects. References are attached 
from the References tab of the Task Details page.

Figure 6-5. Task Details page: References tab

To attach references to a task:

1. Locate the task and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Attach the reference.

Attaching Existing Requests
To attach an existing request to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select Request (Existing) from the New Reference field.
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4. Click Add.

The Add Reference: Request window opens.

5. Search for the request you want to add to the task.

6. Select the checkbox next to the desired request, the desired relationship to 
the request, and click Add.

See Setting Up Predecessors on page 71 for more detailed information on 
predecessor relationships between requests and tasks.

You return to the References tab in the Task Details page. The new 
attached request displays as a reference.

7. Click Save.

Attaching New Requests
A new request can be created from the References tab and immediately 
attached to a task. This saves time from having to create a new request in HP 
Demand Management, searching for it, and attaching it to the task.

To attach a new request to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select Request (New) from the New Reference field.

4. Click Add.

The Create New Request window opens.

5. Select the desired relationship to the new request.

See Setting Up Predecessors on page 71 for more detailed information on 
predecessor relationships between requests and tasks.

6. Select a request type from the Request Type field.

7. Click Create.

The standard interface opens with the request type loaded.

8. Provide any necessary information in the request’s fields.
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9. Click Submit.

The request is submitted. You return to the References tab in the Task 
Details page. The new attached request displays as a reference.

10. Click Save.

Attaching Existing Packages
To attach a package to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select Package from the New Reference field.

4. Click Add.

The Add Reference: Package window opens.

5. Search for the package you want to add to the task.

6. Select the checkbox next to the desired package and click Add.

You return to the References tab in the Task Details page. The new 
attached package displays as a reference.

7. Click Save.

Attaching New Packages
A new package can be created from the References tab and immediately 
attached to a task. This saves time from having to create a new package in 
Deployment Management, searching for it, and attaching it to the task.

To attach a new package to a task:

1. Open the Task Details page.

2. Click the References tab.

3. Select Package (New) from the New Reference field.

4. Click Add.

The Create New Package window opens.
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5. Click Create.

The Package window opens.

6. Provide any necessary information in the package’s fields.

7. Click Save.

The package is submitted. You return to the References tab in the Task 
Details page. The new attached package displays as a reference.

8. Click Save.

Attaching Tasks
To attach a task to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select Task from the New Reference field.

4. Click Add.

The Search Tasks window opens.

5. Search for the task you want to add to the task.

6. Select the checkbox next to the desired task and click Add.

You return to the References tab in the Task Details page. The new 
attached task displays as a reference.

7. Click Save.

Attaching Releases
To attach a release to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select Release from the New Reference field.
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4. Click Add.

The Add Reference: Release window opens.

5. Select a release to add.

6. Click Add.

You return to the References tab in the Task Details page. The new 
attached release displays as a reference.

7. Click Save.

Attaching Documents
To attach a document to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select Attachment from the New Reference field.

4. Click Add.

The Add Document window opens.

5. To select a document for an attachment, click the File Chooser icon.

Open the drive and directory where the file you want to attach is located 
and select it. The name of the document displays in the Attachment field.

6. Type a description in the Description field.

7. Click Add.

You return to the References tab in the Task Details page. The new 
attached document displays as a reference.

8. Click Save.
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Attaching URLs
To attach a URL to a task:

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Click the References tab.

3. Select URL from the New Reference field.

4. Click Add.

The Create New Reference URL window opens.

5. Type the name of the URL in the URL field.

6. Type a description in the Description field.

7. Click Add.

You return to the References tab in the Task Details page. The new 
attached URL displays as a reference.

8. Click Save.

Changing the Task Status
A task’s status can be changed from the Task Details page. See Task Statuses 
on page 93 for detailed discussion of task statuses.

To change a task’s status from its Task Details page

1. Locate the task to be assigned and double-click it.

The Task Details page opens.

2. Select the new task status from the Status field at the top of the page.

3. Click Save.
110 Chapter 6



7 Managing a Project 

In This Chapter:

Overview of Managing a Project
Setting Up a Project

Project Statuses
Adding Tasks to a Work Plan
Taking a Baseline
Revising the Work Plan

Viewing and Modifying Work Plan Hierarchy
Work Plan Statuses
Configuring and Updating Multiple Tasks Simultaneously
Updating Scheduling and Dependencies
Concurrent Work Plan Editing
Viewing the Project Critical Path

Using the Project Overview
Searching for Projects
Viewing the Work Plan
Viewing the Project Health
Viewing Milestones
Viewing Project Earned Value (EV) Analysis
Viewing Project Control Items
Viewing Project Staffing
Viewing Program Associations
Viewing Project Cost Data
Approving Project Time
Viewing Exceptions
Printing the Project Overview
Using the PPM Dashboard to View Progress

Submitting Project Control Items
Logging Issues
Logging Risks
Logging Scope Changes

Viewing Project Settings and Participants
Controlling Project Dates
Working with Baselines

Taking a Baseline
Managing Baselines
Comparing Baselines

Tracking and Analyzing Project Costs
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Exporting and Printing a Work Plan
Exporting to PDF Files
Exporting to Microsoft Excel Files

Tracking Work Plan Audit History
Completing, Cancelling, and Deleting Projects

Completing Work Plans
Canceling Work Plans
Deleting a Project

Overview of Managing a Project
This chapter describes how to oversee a project from inception to completion 
using HP Project Management. 

Business initiatives can be divided into a set of goals that must be met through 
the completion of measurable tasks by assigned resources. The tasks must be 
monitored to determine if they are on schedule. In order to provide 
organization and structure for these activities, a project manager is responsible 
for managing the project and its work plan.

Some common responsibilities for project managers include:

Creating and managing the work plan through ongoing adjustments, scope 
changes, and detailed phase planning.

Tracking progress to ensure that the project is performing well in terms of 
its deliverables and costs.

Communicating project status to participants and stakeholders, including 
the creation and appropriate escalation of project-related issues.

Project managers can integrate and streamline these responsibilities using the 
features of Project Management. The following sections provide instructions 
for performing common Project Management tasks, such as setting up a project 
and tracking its status.

In Project Management, project managers are those users who have specific Project 
Management-related access grants. See the Security Model Guide and Reference for 
details.
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This chapter discusses:

Setting Up a Project

Every project contains a set of options to configure that are specific to the 
project, such as what information is tracked and displayed, the rules for the 
display of indicators and exceptions, scheduling, and who can view the 
work plan. These settings are defaulted by the project type.

Adding Tasks to a Work Plan

After the global options have been configured for a project, tasks and 
summary tasks can be arranged and ordered into a meaningful hierarchy.

Taking a Baseline

Project managers can take a baseline of their work plans, which can be 
used to monitor a work plan’s changes as it moves through its life cycle.

Revising the Work Plan

A project manager may also want to make revisions to the work plan. After 
making revisions, a project manager might find it necessary to then 
reschedule the work plan. This includes recalculating start and finish dates.

Using the Project Overview

Managers can search for projects, as well as track a particular project’s 
progress using its project health. Any exceptions that have been triggered 
can also be displayed.

Tracking and Analyzing Project Costs

Project cost data can be collected and analyzed by the project manager to 
track budgets, compare project sizes, or spot potential trouble.

Tracking Work Plan Audit History

The project itself, including fields in the work plan, can have their status 
changes recorded and viewed for projects and tasks.

Exporting and Printing a Work Plan

Project managers can print a work plan and Gantt chart, with a wide range 
of filtering options. The Gantt chart can also be exported to an image file 
and used in presentations.
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Setting Up a Project
A project in HP Project Management is made up of the following components:

Project settings

Project details

Work plan

Tasks

Summary tasks

Activities

Notes

References 

These components are used to define and process a specific business initiative. 
The project also contains a number of global settings that can be configured to 
suit a particular project’s objectives. These settings are defined by project 
policies, which are defined by the project type. Depending on the configuration 
of project policies, some of these settings may not be editable. See the 
following sections for more information on project policies:

Project Fields on page 38

Work Plan on page 40

Request Types on page 41

Scheduling on page 42

When a user creates or edits a work plan or summary task, that user is the only one 
able to save changes.
In the case of two users wanting to edit two different summary tasks under one 
project, opening and editing only the desired summary tasks will enable each user to 
save changes without interfering with each other.
See Concurrent Work Plan Editing on page 127 for more detailed information.

When you import a large Microsoft Project (or a large number of projects) into HP 
Project Management, tables in the PPM Center database are updated to handle this 
new configuration. Because of the scope of database changes, you should re-run the 
database statistics on your PPM Center database. Contact your application 
administrator for help with this procedure.
114 Chapter 7



Schedule Health on page 44

Cost and Effort on page 45

Cost and Earned Value Health on page 50

Microsoft Project Integration on page 51

Project Health on page 53

Issue Health on page 54

Task Auditing on page 55

Project Security on page 55

Project Statuses
The Project Details tab of the Project Overview page displays the status of the 
project in its process. These statuses can vary depending on whether the 
process has been altered (see the HP Project Management Configuration 
Guide for details). The default set of project statuses is as follows:

In planning

On Hold

Active

Complete

Cancelled

Adding Tasks to a Work Plan
Once the project has been configured, the project manager can add tasks to the 
work plan and specify task details, including assigning resources or resource 
groups. Tasks can be added individually, or the work plan can be created based 
on a pre-defined work plan template. Tasks can also be organized in a 
hierarchical fashion quickly and easily.

See the following chapters and sections for more details on including tasks in a 
work plan:

Adding Tasks to the Work Plan on page 68

Configuring Tasks on page 91

Using Work Plan Templates on page 173
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Taking a Baseline
A baseline is the original approved work plan for a project. As scope changes 
happen, the baseline is updated to reflect those changes as part of the approved 
plan. A project manager uses baselines to continuously monitor the health of 
their work plan in terms of schedule and cost by comparing the current work 
plan to the baseline.

See Working with Baselines on page 146 for more detailed information about 
taking and using work plan baselines.

Revising the Work Plan
Work plans rarely remain unchanged during a project’s life. Revisions are 
commonly made to accommodate project updates, reorganizations and 
reassignments. HP Project Management enables project managers to revise 
their plan quickly. 

Viewing and Modifying Work Plan Hierarchy
The ordering and grouping of tasks and summary tasks is graphically displayed 
in the Work Plan page.

Figure 7-1. Work Plan page: Schedule view

When a user creates or edits a work plan or summary task, that user is the only one 
able to save changes. See Concurrent Work Plan Editing on page 127 for more 
detailed information.
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Tasks can be grouped and ordered into summary tasks, using the indent icon to 
indent. Summary tasks can have their tasks removed and made into separate 
tasks using the outdent icon to outdent. Top-to-bottom reordering can be 
performed on summary tasks and tasks as well, using the Cut and Paste icons. 
For step-by-step instructions, see Creating Work Plan Hierarchy on page 69.

Work Plan Statuses
To display the different stages in a work plan’s life from planning to 
completion, a work plan can have various statuses associated with it. These 
statuses are In Planning, On Hold, Active, Completed and Cancelled. Project 
managers can move work plans into different statuses to facilitate the work 
associated with that stage of the project. Table 7-1 describes the various work 
plan statuses, their behaviors, and applications.

Table 7-1. Work plan statuses and descriptions (page 1 of 2)

Work Plan Status Behavior Application

In Planning

Work plans and their tasks are not shown in 
the My Tasks portlet or the PPM 
Dashboard.
Notifications are not sent and exceptions 
are not triggered.
All work plans start in this status.

This status allows a project 
manager to develop and 
manipulate the work plan 
without having to notify 
participants or stakeholders.

Active

Work plans and their tasks can be seen in 
My Tasks and in the PPM Dashboard.
Notifications are sent and exceptions are 
triggered.
Work plan structure can change.

This is the status of a work plan 
that is ready to be executed and 
is being actively managed.
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HP Project Management also features a set of task statuses. For a list of task 
statuses, see Task Statuses on page 93.

On Hold
Notifications are not sent and exceptions 
are not triggered.
Hierarchy can be modified.

This status is used when a 
portion of an active plan needs 
to be withheld from execution, 
perhaps because it needs 
replanning or because work is 
being temporarily suspended 
while a review takes place. It is 
possible to put an entire work 
plan in this status.

Completed

Work plans and their tasks can be seen in 
the PPM Dashboard but not in My Tasks.
Notifications are not sent and exceptions 
are not triggered.

This is the status of a work plan 
that has been worked to 
completion. Tasks cannot be 
added to a section that is 
Completed.

Cancelled

Work plans and their tasks can be seen in 
the PPM Dashboard but not in the My 
Tasks portlet.
Notifications are not sent and exceptions 
are not triggered.

This status is used to indicate 
that the deliverables in this 
section of a work plan will not 
be completed, and are no 
longer required to be completed 
in order for the project to finish.

Table 7-1. Work plan statuses and descriptions (page 2 of 2)

Work Plan Status Behavior Application
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Modifying Statuses

Project managers can change statuses for the entire work plan, summary tasks, 
or tasks at any time.

To change the status of the project:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. In the Schedule view, double-click the row at the top of the hierarchy.

The Task Details page opens.

4. Select a new Status at the top of the page.

5. Click Save.

To change the status of a task or summary task:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. In the Schedule view, double-click the task or summary task whose status 
you want to change.

The Task Details page opens.

4. Select a new Status at the top of the page.

5. Click Save.

A work plan in the status Completed or Cancelled cannot be edited. The project must 
be re-opened in order for the work plan to be edited.
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Configuring and Updating Multiple Tasks Simultaneously
You can select multiple tasks in the Work Plan page and perform simultaneous 
updates on them in the following ways:

Editing certain fields common to all selected tasks

Updating actuals for selected tasks

Changing resource assignments for selected tasks

Changing assigned roles for selected tasks

Shifting scheduled dates for selected tasks forward or backward

Linking selected tasks sequentially as predecessors

Setting status for selected tasks

Use either of the following methods to select multiple tasks simultaneously:

Use Shift + click to highlight a set of contiguous rows.

Use Ctrl + click to make multiple non-contiguous selections.

Editing Fields on Multiple Tasks Simultaneously

Certain fields common to all tasks can be edited and saved simultaneously for 
any set of tasks, including but not limited to:

Name

Scheduled duration

Resource

Activity

To edit common fields for a set of tasks simultaneously in the Quick Edit page:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
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3. Select multiple tasks using Shift + click or Ctrl + click.

You must select an uninterrupted range of tasks in order to open them in 
the Quick Edit page. Collapsed summary tasks can be included.

4. Click Edit and select Quick Edit.

The Quick Edit page opens.

5. Make the desired changes to the set of tasks.

6. Click Save.

The changes are saved.

Updating Actuals for Multiple Tasks Simultaneously

Actuals data can be edited simultaneously for any set of tasks.

To update actuals for a set of tasks simultaneously:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Select multiple tasks using Shift + click or Ctrl + click.

4. Click Edit and select Actuals.

The Enter Actuals page opens.

5. Make the desired updates to the set of tasks.

6. Click Save.

The changes are saved.

When actuals are entered into HP Project Management, certain calculations are 
deferred. See Calculating Actuals on page 127 for more details.

If HP Time Management has been enabled for a project, you may not be able to enter 
Actual Effort values for resources whose actuals are expected to be entered through 
HP Time Management time sheets. These tasks are marked with an icon resembling 
a clock.
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Changing Resource Assignments for Multiple Tasks Simultaneously

Resource assignments can be edited simultaneously for any set of tasks in the 
following ways:

A particular resource or set of resources can be assigned to all selected 
tasks.

A particular resource or set of resources can be removed from all selected 
tasks.

Resources whose assignments have actuals cannot be removed from a task.

A particular resource on all selected tasks can be swapped with another 
resource.

Assignments that have already started are not swapped. If task scheduled 
effort is being managed manually, the new resource inherits the old 
resource’s scheduled effort.

Resource assignments on all selected tasks can be removed without 
affecting tasks that have already started.

Tasks with actuals are not changed.

All resource assignments on all selected tasks can be replaced with another 
resource or set of resources.

Tasks with actuals are not changed. If task scheduled effort is being 
managed manually, the new resource’s scheduled effort is set to zero.

To change resource assignments for a set of tasks simultaneously:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Select multiple tasks using Shift + click or Ctrl + click.

4. Click Edit and select Assignments.

The Resource Assignments dialog opens.

5. Make the desired changes to the resource assignments for the selected 
tasks.
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6. Click OK.

The changes are saved immediately.

Changing Assigned Roles for Multiple Tasks Simultaneously

The assigned role can be edited simultaneously for any set of tasks. The new 
role takes the place of any previous role assignments for all the tasks in the set.

To change resource assignments for a set of tasks simultaneously:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Select multiple tasks using Shift + click or Ctrl + click.

4. Click Edit and select Set Role.

The Set Role dialog opens.

5. Select the desired role for the selected tasks.

6. Click OK.

The changes are saved immediately.

Shifting Scheduled Dates for Multiple Tasks Simultaneously

You can shift the scheduled dates for any set of tasks forward or backward by 
any number of days. All of the selected tasks will shift the same number of 
days in the same direction.

To shift the scheduled dates for a set of tasks simultaneously:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

This feature should only be used if you are not using the HP Project Management 
scheduler (accessed by clicking the Schedule Project icon) as described in 
Scheduling the Work Plan on page 76. If you have been using the scheduler, 
continuing to do so is the recommended method for scheduling your work plan.
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2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Select multiple tasks using Shift + click or Ctrl + click.

4. Click Edit and select Shift Schedule.

The Shift Task Schedule dialog opens.

5. Enter the number of days by which to shift the schedule and select Forward 
or Backward.

6. Click OK.

The changes are saved immediately.

Quickly Linking Multiple Tasks as Predecessors

You can select a set of tasks and quickly link them sequentially as 
predecessors. The tasks will be assigned predecessor relationships based on 
their sequential order as defined by the work plan.

To change resource assignments for a set of tasks simultaneously:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Select multiple tasks using Shift + click or Ctrl + click.

4. Click Edit and select Link Tasks.

The Link Tasks dialog opens.

5. Click Link Tasks.

The changes are saved immediately.
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Setting Status for Multiple Tasks Simultaneously

Task status can be edited simultaneously for any set of tasks.

To change resource assignments for a set of tasks simultaneously:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Select multiple tasks using Shift + click or Ctrl + click.

4. Click Edit and select Set Status.

The Set Status dialog opens.

5. Select the desired status for the selected tasks.

6. Click Change Status.

The changes are saved immediately.

Updating Scheduling and Dependencies
Project managers are able to update aspects of a project at any time to reflect 
the changing status of a business initiative. Many of these aspects are task 
details that can be edited in batches as described in Configuring and Updating 
Multiple Tasks Simultaneously on page 120.

Changing Scheduled Duration, Start, and Finish

Many different task factors influence the work plan schedule, including their 
duration, start dates, constraints, and predecessor relationships. The Scheduled 
Duration, Scheduled Start, and Scheduled Finish fields can be changed in the 
Task Details page.

To change Scheduled Duration, Start, or Finish for a task:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.
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2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. In the Schedule view, double-click the task to update. 

The Task Details page opens.

4. Update fields in the Schedule tab.

To update Scheduled Start and Finish dates, type the desired date in the 
appropriate date field. To make sure these dates are set explicitly and will 
not change after the Schedule Project icon is clicked, select a Constraint 
Type (such as Start No Earlier Than) from the Constraint Type field.

To update Scheduled Duration, type the new information into the 
appropriate text field.

5. Click Save.

Changing Predecessors

You can specify different predecessor relationships between tasks in the work 
plan; for example, that some tasks must be completed before beginning other 
tasks. Predecessors can be changed from the Task Details page.

External tasks and requests can also be set as predecessors for tasks. For more 
information on setting these types of predecessors, see Setting Up 
Predecessors on page 71.

Revising the Schedule

If you have modified any of your work plan’s hierarchy, predecessor 
dependencies, resources or dates, you might want to revise the schedule. 
Scheduling warnings can help you identify places where tasks are not meeting 
their dependencies.

When you reschedule the work plan, HP Project Management generates a new 
schedule for the entire work plan based on the updated dates, working from the 
default date specified by the project type in the Scheduling policy. Depending 
on the project type, you may be able to change the default date in the Project 
Settings page.

If you want to update a summary task’s Scheduled Duration, Start, or Finish, you must 
update its individual tasks’ values.

Only one user at a time can reschedule the work plan.
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For more detailed information on updating a schedule, see Generating the 
Schedule on page 76.

Once you are satisfied with the new schedule, you may want to take a new 
baseline for the work plan. See Taking a Baseline on page 116 for more 
detailed information.

Concurrent Work Plan Editing
While only project managers should be editing a work plan, a single project 
may have many project managers who are editing different parts of the work 
plan. HP Project Management allows you to edit and update separate parts of 
work plans simultaneously, allowing for more efficient representation of 
changes to a project.

Avoiding Conflicts

In general, two users cannot make edits to the same task simultaneously.

If two users are editing a task simultaneously, the only changes saved will 
be the first set. The second user will not be able to save any changes. This 
includes instances where a resource logs actuals for a task.

For example: Yukio is the manager for a project to which Bob is assigned.

a. Yukio opens a task and begins to make changes.

b. Bob updates the actuals for that task using the My Tasks portlet and 
clicks Save.

c. Yukio is unable to save her changes to the task.

An error message results if a user attempts to schedule the work plan while 
the work plan is being scheduled by another user.

It is recommended that project managers avoid making changes to the work 
plan during times when many resources will be entering actuals.

Calculating Actuals

When resources enter actuals through the My Tasks portlet or time sheets, the 
associated task information is saved, but the following calculations are 
deferred in order to allow resources to efficiently enter and save actuals:

Rollup of cost data to parent summary tasks

Calculation of exception

Calculation of health
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The schedule health and Work Plan page of a project display messages 
indicating that outstanding calculations are pending. The interval at which 
these calculations are made is determined by a parameter in the server.conf 
file on the PPM Server, which can be configured by a system administrator. A 
different parameter in the server.conf file makes it possible to configure HP 
Project Management to perform rollup calculations upon save. See the HP 
Project Management Configuration Guide for more detailed information on 
these server parameters.

Viewing the Project Critical Path
A work plan’s critical path is composed of all of the tasks in a work plan that 
determine its duration. The Display Options dialog box offers two ways to 
make the critical path visible:

The Highlight Critical Path checkbox allows you to display the critical path 
in the project Gantt chart. Tasks that are part of the critical path are 
outlined in orange.

The Mark Tasks on Critical Path checkbox allows you to mark tasks on the 
critical path with an orange flag present in all work plan views.

Figure 7-2. Work Plan page: Gantt view displaying critical path

The critical path is calculated after scheduling the work plan. If you have made 
changes to the work plan, you should reschedule it in order to obtain an accurate 
critical path.
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To see a work plan’s critical path on the Gantt chart:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Click Actions and select Configure Display.

The Display Options dialog box opens.

4. Select the Highlight Critical Path checkbox.

5. Click Done.

The Gantt chart displays the project’s critical path.
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Using the Project Overview
The Project Overview page provides a centralized, consolidated view of the 
project’s statuses in many areas. It also serves as a central navigation point to 
the entities associated with the project, such as its budget and staffing profile, 
forming a consolidated hub of communication between the project manager 
and others interested in the project. The sections of the Project Overview page 
are self-configuring, appearing when they are relevant for the project, and only 
to users who have the proper level of access, such as cost-related sections. 
Using the Project Overview page and its sections, project managers can keep 
track of the items described in Table 7-2:

Table 7-2. Project Overview page tabs and sections

Tab Possible Sections and Uses

Project Summary

The progress of work plan phases and major 
milestones
Exceptions that have been triggered
Project issues
Project risks
Project scope changes
Project staffing
Project cost data including budgets and earned value 
(EV) analysis
HP Time Management integration
Programs the project is linked to

Project Details
Project summary
Business case details
Risk and value ratings

Project Exceptions Exceptions triggered by work plan tasks

References References attached to the project
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Searching for Projects
The Search Projects page is used to locate and open projects.

To locate and open a project:

1. Log on to PPM Center.

2. From the menu bar, select Project Management > Projects & Tasks > Search 
Projects.

The Search Projects page opens.

3. Provide search criteria in the appropriate fields.

4. Click Search.

The Project Search page reloads, displaying the results of your search.

5. Click the name of a project to open its Project Overview page.
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Viewing the Work Plan
The Work Plan section of the Project Summary tab in the Project Overview 
page displays the top level tasks in the project work plan.

Figure 7-3. Project Summary tab: Work Plan section

You can take the following actions from the Work Plan section:

Click Edit Work Plan to open the Schedule view and edit the work plan. See 
Revising the Work Plan on page 116 for more details on editing the work 
plan.

Click View Baselines to open the View Baselines page and manipulate 
project baselines. See Working with Baselines on page 146 for more details 
on working with baselines.

Viewing the Project Health
The project summary condition is a graphical indicator of the health and 
percent complete of a project, located on the Project Summary tab in the 
Project Overview page beneath the project name.

Figure 7-4. Project summary condition indicator

The color of the summary condition is a weighted average of the health 
indicators for Scheduling, Issue Health, and Cost and Earned Value Health. 
These indicators appear on the Project Overview page as well.

Figure 7-5. Project health indicators

For more detailed information on how the project summary condition is 
calculated and configured, see Project Health on page 53.
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The project summary condition also appears in its own column next to the 
names of all projects in the Project Search page. 

Overriding Project Health

You may wish to override the health color for any number of reasons, 
including:

Project resources have fallen behind in reporting their actuals information, 
causing HP Project Management to reflect an out-of-date situation.

An input error by a manager on a summary task has resulted in inaccurate 
project health calculations.

To override the project summary condition indicator’s health color:

1. On the Project Summary tab in the Project Overview page, click Override 
Health.

The Override Health dialog box opens.

2. Select the desired indicator color or choose to use the calculated color.

3. Type the date until which the override will last.

4. If desired, provide a reason for the override in the Override Description text 
box.

5. Click Done.

Viewing Milestones
The Project Summary tab in the Project Overview page contains two sections 
that display milestones:

The Milestones section lists the milestones in a work plan.

If the project’s Project Fields policy has been set to track major milestones, 
the Milestones section will only list major milestones. If major milestones 
have not been specified, all milestones are displayed.
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Figure 7-6. Project Summary tab: Milestones section

The Work Plan section shows part of the work plan’s Gantt chart, including 
top-level tasks and milestones.

Milestones are visible in the Work Plan page Gantt view as black diamonds in 
the Gantt chart.

Figure 7-7. Work Plan page: Gantt view

Viewing Project Earned Value (EV) Analysis
The EV Analysis Summary section of the Project Summary tab in the Project 
Overview page provides an earned value (EV) analysis for the project based on 
the latest data.

Click Analyze to open the Analyze Cumulative Cost Metrics page for the 
project.

For detailed information on analyzing cumulative cost metrics for a project, 
see the HP Financial Management User’s Guide.
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Viewing Project Control Items
The Project Summary tab in the Project Overview page can display sections 
devoted to listing and logging project control items such as issues, risks, or 
scope changes.

For example, the Issues section of the Project Summary tab in the Project 
Overview page summarizes the issues logged for a project. Issues associated 
with the project appear in the following order:

1. Escalated open issues (ordered by priority)

2. Other open issues (ordered by priority)

3. Closed issues (ordered by priority)

Figure 7-8. Project Summary tab: Issues section

You can take the following actions from the Issues section:

Click Log Issue to log another issue. See Logging Issues on page 140 for 
more detailed information on logging project issues.

Click Show Full List to show the full list of issues logged for the project.

For more detailed information on these sections, see Submitting Project 
Control Items on page 140.

Viewing Project Staffing
The Project Staffing section of the Project Summary tab in the Project 
Overview page lists the staffing profiles associated with the project and their 
status.

Figure 7-9. Project Summary tab: Project Staffing section

You can create a new staffing profile from the Project Staffing section by 
clicking Create a Staffing Profile.
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For more detailed information on staffing profiles and their creation and use, 
see the HP Resource Management User’s Guide.

Viewing Program Associations
The Program Associations section of the Project Summary tab in the Project 
Overview page lists the programs project is associated with.

Figure 7-10. Project Summary tab: Program Associations section

HP Program Management provides a way for managers to link multiple 
projects together as programs, and to submit and track requests against them.

Organizations implement a Program Management Office in order to:

Ensure alignment of IT projects with business objectives

Eliminate duplicate and non-priority efforts

Improve operational efficiency

Leverage resources

Ensure on-time and on-budget delivery

Programs can be tracked and analyzed with the same kind of familiar cost 
metrics as projects.

For more detailed information on HP Program Management, see the HP 
Program Management User’s Guide.

The Program Associations section only appears if you have purchased and installed 
HP Program Management.
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Viewing Project Cost Data
The Project Cost section of the Project Summary tab in the Project Overview 
page displays cost data for the project.

Figure 7-11. Project Summary tab: Project Cost section

You can take the following actions from the Project Cost section:

Click Cost Details to open the Cost Details page for the project, which 
shows more detailed project cost information alongside project budget 
information, if one exists.

Click Create a Budget to create a new budget for the project. See the HP 
Financial Management User’s Guide for more detailed information on 
budgets and their creation and use.

Approving Project Time
HP Time Management can be used in conjunction with HP Project 
Management for detailed entry of time and effort actuals using time sheets. 
Time sheets have their own sets of approvers and approval processes, and can 
be used for more granular cost reporting. The Approve Project Time section of 
the Project Summary tab in the Project Overview page displays data for time 
sheets with lines pertaining to the project, and allows you to approve or reject 
them directly.

To approve or reject the time sheets listed in the Approve Project Time section, 
select the checkboxes next to the desired time sheets and click Approve or 
Reject.

Viewing Exceptions
Exceptions indicate that a rule that has been defined in the project has been 
violated for a particular task. For example, resources have not been assigned to 
a task that is due to begin soon, or a task is being completed a certain number 
of days late. Exception rules are configurable; for more detailed information, 
see Schedule Health on page 44.

Tasks that have triggered exceptions can be viewed from the Project 
Exceptions tab in the Project Overview page or the Schedule view in the Work 
Plan page.
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Figure 7-12. Project Overview page: Project Exceptions tab

Viewing Exceptions from the Project Overview Page

The Project Exceptions tab lists all the tasks in a particular project that have 
triggered exceptions.

To get to the Project Exceptions tab for a project:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click the Project Exceptions tab.

The Project Exceptions tab opens.

3. Drill down to any tasks that merit attention.

Viewing Exceptions in the Schedule View

Exceptions that have been triggered display as a red exclamation mark in the 
first column on the left in the Schedule view on the Work Plan page.

To view a particular triggered exception for a task:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Double-click a task in the Schedule view.

The Task Details page opens.
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4. Click the Exceptions/Warnings tab.

The Exceptions/Warnings tab lists the exception and schedule warning 
rules for the project that the task is violating.

Printing the Project Overview
You can create a simple, unified version of the Project Overview page suitable 
for printing or exporting to a PDF file.

To create a printable or exportable view of the Project Overview page:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click the Printable View link.

The Print Options window opens.

3. Select the project overview data you want to display.

You can select the Remember these settings checkbox if you want HP 
Project Management to use these as default settings in the future.

4. Click OK.

The printable Project Overview page opens.

Depending on whether you have the proper access grant to edit the task, you may not 
be able to edit the task’s fields. Users who can only view a task include project 
participants who have not been assigned to that particular task, as well as project 
managers who are not managing the project within which that particular task is 
contained.
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5. Print or export the Project Overview page.

Click Print to print the page.

Click PDF Options to open the PDF Settings window, which allows you 
to configure settings for exporting the page to a PDF file.

Using the PPM Dashboard to View Progress
Project managers can also view projects using the PPM Dashboard. This 
interface comes with a configurable set of application windows, known as 
portlets, through which common HP Project Management queries and actions 
can be performed.

Submitting Project Control Items
HP Project Management allows you to log issues, risks, and scope changes 
against a particular project. These items can be tracked and logged from their 
own sections of the Project Summary tab in the Project Overview page.

Logging Issues
Project issues can be submitted against a particular project to raise issues that 
require attention. Once submitted, project issues follow their own workflow to 
resolution.

You can log an issue for a project from the following locations:

The Log Issue button in the Issues section of the Project Summary tab in 
the Project Overview page.

The menu bar option Project Management > Project Controls > Submit a 
Project Issue.

If the PDF Options link is not visible, it has been disabled by a system administrator.

If the Request Types policy in the project type does not specify a request type for a 
project control item, the Log <Project Control Item> button in the corresponding 
section on the Project Overview page does not appear.
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To log an issue for a project:

1. Open a project and click Log Issue or select Project Management > Project 
Controls > Submit a Project Issue at any time.

The Create New Project Issue page opens.

2. Fill in all required fields and any desired optional fields.

3. Click Submit.

The issue is submitted and begins processing along its workflow.
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Logging Risks
Risks can be submitted against a particular project to raise serious issues that 
require attention. Once submitted, risks follow their own workflow to 
resolution.

You can log a risk for a project from the following locations:

The Log Risk button in the Risks section of the Project Summary tab in the 
Project Overview page.

The menu bar option Project Management > Project Controls > Submit a 
Risk.

To log a risk for a project:

1. Open a project and click Log Risk or select Project Management > Project 
Controls > Submit a Risk from the menu bar at any time.

The Create New Project Risk page opens.
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2. Fill in all required fields and any desired optional fields.

3. Click Submit.

The risk is submitted and begins processing along its workflow.

Logging Scope Changes
Scope changes can be submitted against a particular project to raise possible 
changes in project scope that require attention. Once submitted, scope changes 
follow their own workflow to resolution.

You can log a risk for a project from the following locations:

The Log Scope Change button in the Scope Changes section of the Project 
Summary tab in the Project Overview page.

The menu bar option Project Management > Project Controls > Submit a 
Scope Change.

To log a scope change for a project:

1. Open a project and click Log Scope Change or select Project Management > 
Project Controls > Submit a Scope Change from the menu bar at any time.

The Create New Project Scope Change Request page opens.
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2. Fill in all required fields and any desired optional fields.

3. Click Submit.

The scope change is submitted and begins processing along its workflow.
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Viewing Project Settings and Participants
Project settings and participants can be viewed or adjusted at any time during a 
project’s execution.

For more detailed information on project settings and their interaction with 
project policies, see Setting Project Policies on page 38.

For more detailed information on project participants and configuring the 
list thereof, see Defining Project Participants on page 62.

Controlling Project Dates
The following entities relevant to projects have effective start and end dates 
associated with them:

Projects. The Project Details tab in the Project Overview page contains the 
project’s Planned Start and Finish Period.

Work plans. The work plan for a project represents the scheduled start and 
end dates of major deliverables for the project.

Staffing profiles. The staffing profile for a project has a Start and End 
Period.

Budgets. The budget for a project has a Start and End Period.

Financial benefits. The financial benefit for a project has a Start and End 
Period.

The Planned Start and Finish Period for a project take precedence over the 
other dates.

If the work plan’s Scheduled Start or Finish Date falls outside the project’s 
existing date range, a scheduling warning is triggered when the work plan 
is scheduled.

Start Period values for staffing profiles and budgets associated with a 
project are automatically synchronized with the values specified in the 
Project Details tab. The Start Period for the project’s financial benefit are 
also synchronized with the project, but is offset from the actual Start 
Period.
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Working with Baselines
A baseline is a snapshot of the approved work plan. As scope changes happen, 
the baseline is updated to reflect those changes as part of the approved plan. A 
project manager uses baselines to continuously monitor the health of their 
project in terms of schedule and cost by comparing the current work plan to the 
baseline plan. Only users with the appropriate access grants can view and 
manipulate baselines.

Taking a Baseline
To take a baseline:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click View Baselines.

The View Baselines page opens.

3. Click Create Baseline.

The Create Baseline dialog box opens.

4. Type a Name and optional Description for the baseline.

A default name for the baseline is suggested, though you can change it.

5. Click Create.

The baseline has been taken.
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Managing Baselines
Multiple baselines can be taken for a single work plan. You can update the 
names and descriptions of baselines, specify which is the active project 
baseline, or delete baselines at any time.

To manage project baselines:

1. Open the project you have taken baselines of.

2. On the Project Overview page, click View Baselines.

The View Baselines page opens.

3. Select the option next to the baseline you want to be active for the project.

4. (Optional) Click the Delete icon next to a baseline you wish to delete.

a. A dialog box will open asking if you are sure you want to delete the 
baseline.

b. Click Delete to delete the baseline.

5. Click Done.

Comparing Baselines
You can compare baselines to each other, or a baseline to the current work 
plan. On the View Baselines page, click Compare Baselines to open and run 
the report that allows you to compare a baseline to another baseline, or to the 
current work plan.

To take a baseline for a project, you must have a license for HP Project Management, 
be a manager for the project, and have the Manage Work Plan Baselines access 
grant. Users with the Manage All Work Plan Baselines access grant can take 
baselines for any project.
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Tracking and Analyzing Project Costs
HP Financial Management allows you to track and analyze project costs in 
ways including the following:

Capturing and comparing financial data in budgets including rollups from 
work plans 

Using HP Time Management to track task costs

Performing analyses of project cost data in graph and portlet form, 
including earned value analysis

Enabling SOP 98-1 compliance at the work plan level with activities

Enabling the use of different currencies depending on project participants’ 
locations

See the HP Financial Management User’s Guide for more detailed 
information on cost data, budgets, currencies, exchange rates, and SOP 98-1 
compliance.

Exporting and Printing a Work Plan
A work plan can be exported as a PDF file or a Microsoft Excel file for use in 
presentations.

Exporting to PDF Files
To export a work plan to a PDF file:

1. Open the project to export.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Adjust the work plan display.

You can adjust the set of displayed tasks by reordering or resizing columns, 
expanding or collapsing summary tasks, or filtering the work plan in order 
to display the tasks you want.
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4. Click the PDF icon.

The PDF Export Options dialog box opens.

5. Select the desired options for the display of the project Gantt chart, the 
included columns, and paper size.

6. Click Export.

The project PDF file opens in a new window, where it can be viewed and 
saved.

Exporting to Microsoft Excel Files
To export a work plan to a Microsoft Excel file:

1. Open the project to export.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Click the Microsoft Excel icon.

A new window opens, refreshing at a set interval until the system 
completes the export.

4. Save the exported Excel file.
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Tracking Work Plan Audit History
HP Project Management maintains an audit trail for projects, work plans, and 
tasks.

To view the audit trail for a particular project:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Project Audit Trail.

The Project Audit Trail dialog box opens.

Click Prev or Next to navigate between pages of information. You can also 
click the Export to Excel link to export the dialog box’s contents to a 
Microsoft Excel file.

3. Click the X icon in the upper-right corner to close the dialog box.

To view the audit trail for a particular work plan:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. Click the View Audit Trail link on the Work Plan page.

The Work Plan Audit Trail dialog box opens.
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Click Prev or Next to navigate between pages of information. You can also 
click the Export to Excel link to export the dialog box’s contents to a 
Microsoft Excel file.

4. Click the X icon in the upper-right corner to close the dialog box.

To view the audit trail for a task:

1. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

2. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.

3. In the Schedule view, double-click the task to update. 

The Task Details page opens.

4. Click View Task Audit Trail.

The Task Audit Trail dialog box opens.

Click Prev or Next to navigate between pages of information. You can also 
click the Export to Excel link to export the dialog box’s contents to a 
Microsoft Excel file.

5. Click the X icon in the upper-right corner to close the dialog box.
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Completing, Cancelling, and Deleting Projects
All projects must reach an endpoint. The project can either be brought to 
completion, or reach a point where no more work can be done. Work plan 
statuses provide distinct ways of differentiating between work plans that have 
been Completed or Cancelled. For more detailed information on work plan 
statuses, see Work Plan Statuses on page 117. Projects can also be deleted by 
users with the proper level of access.

Completing Work Plans
Project managers can set the work plan status to Completed. For more 
information, see Modifying Statuses on page 119.

If a work plan is manually set to Completed:

Any incomplete tasks are set to Completed.

Any incomplete summary tasks are set to Completed.

Canceling Work Plans
Occasionally, all work on a particular business initiative can be stopped. The 
endeavor might have been found to be unprofitable, it might not be feasible 
given current resource limitations or there might be another business reason. 
Tasks can have their statuses changed to Cancelled to reflect this circumstance. 

If a work plan is manually set to Cancelled, any incomplete tasks under it 
are set to Cancelled.

From Cancelled, a work plan can be moved back to On Hold.

Once the work plan is moved into an Active summary task status:

Task statuses will be recalculated.

Tasks previously In Progress will not regain the task status of In 
Progress.
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Deleting a Project
Sometimes projects are created in error. Project managers can delete projects 
from the Project Overview page. On the Project Summary tab of the Project 
Overview page, click Delete to delete a project.

Table 7-3 describes the conditions that must be met in order for you to be able 
to delete a project or projects.

Once deleted, a project cannot be recovered. Use caution when considering projects 
for deletion.

Table 7-3.  Access requirements for project deletion

Item to Delete Access Requirements

A single project
Project manager for the project
Access grant: Delete Projects
Access grant: Edit Projects

A single project with 
actuals

Project manager for the project
Access grant: Delete Projects
Access grant: Delete Projects with Actuals
Access grant: Edit Projects
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8 Updating Tasks: Resource Activities

In This Chapter:

Locating Tasks
Finding Tasks Using the My Tasks Portlet
Searching for Tasks and Projects
Finding Tasks Using Notifications

Viewing Project Information
Viewing Project Overview
Viewing Exceptions
Viewing Project References
Viewing the Project Gantt Chart
Viewing the Critical Path
Viewing Project Milestones
Viewing Resource Information

Exporting Your Task Schedule
Updating Tasks

Using the My Tasks Portlet
Using the Task Page

Viewing and Modifying References
Adding References to Tasks
Viewing and Editing References
Deleting References
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Locating Tasks
HP Project Management defines resources as users who work on tasks as part 
of a project team, but do not have the administrative responsibilities of a 
project manager.

Resources update their task status in HP Project Management. There are 
several different ways for participants to locate their tasks:

Finding Tasks Using the My Tasks Portlet

The My Tasks portlet makes users aware of the tasks they should be 
working on. It allows users to update actuals for multiple tasks at once, as 
well as providing links to individual task pages.

Searching for Tasks and Projects

Resources can update notes or references for tasks by searching for the 
tasks directly, or by searching for projects in order to get to the tasks they 
want through the work plans that contain them.

Finding Tasks Using Notifications

Tasks can be reached from a notification simply by clicking on the link 
provided in the body of the email, or by copying and pasting it into any 
Web browser.

Finding Tasks Using the My Tasks Portlet
The My Tasks portlet is available to all users with a HP Project Management 
or HP Time Management license and the View Projects, Update Tasks, or Edit 
Projects access grant. This portlet is included on your PPM Dashboard by 
default. It shows a configurable list of the tasks currently assigned to the user.

Participants can update task actuals and fill in information that the project 
manager would like to collect for all tasks displayed. Task information that can 
be updated may differ from project to project, depending on the project type 
and whether the project is integrated with HP Time Management. In this way, 
the My Tasks portlet can save valuable time by providing a single point for 
multiple tasks to be updated at once. See Using the My Tasks Portlet 
on page 167 for detailed information on using the My Tasks portlet to update 
task information.

The participant can also click on the name of a task in the task list to view the 
Task page. See Using the Task Page on page 168 for more information.
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Searching for Tasks and Projects
Participants can search for tasks and projects that match certain criteria using 
the Task Search and Project Search pages.

Locating Tasks Using the Task Search Page

Project participants with a Project Management license and the View or Edit 
Projects access grant can search for tasks using the Task Search page. Task 
notes and references can be updated in this manner.

To locate tasks in HP Project Management:

1. Log on to PPM Center.

2. From the menu bar, select Project Management > Projects & Tasks > Search 
Tasks.

The Task Search page opens.

3. Provide the search criteria for the desired task.

You can search for an existing task based on any of the fields located on 
the Task Search page. Limiting the maximum number of results in the 
Results Displayed Per Page field can yield quicker results.

4. Click Search.

The Task Search page reloads, displaying the results matching your search 
criteria.
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5. Click on the name of any task in the list to view its Task page. 

See Using the Task Page on page 168 for more information.

Locating Projects Using the Project Search Page

While resources can locate and view projects, only participants with the Edit 
Projects access grant can edit tasks in the work plan. Participants can locate 
projects using the Project Search page. 

To search for projects in HP Project Management:

To locate and open a project:

1. Log on to PPM Center.
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2. From the menu bar, select Project Management > Projects & Tasks > Search 
Projects.

The Search Projects page opens.

3. Provide search criteria for the appropriate fields.

4. Click Search.

The Project Search page reloads, displaying the results of your search.

5. Click on the name of a project to view its Project Overview page. 

See Viewing Project Overview on page 160 for more information.
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Finding Tasks Using Notifications
Email notifications can be configured by project managers to include 
hyperlinks to tasks in HP Project Management. If you have received an email 
containing a link to a task, click on it, and it will open to that task’s Details 
page in your Web browser. If your email client doesn’t handle HTML links 
directly, copy and paste it into your Web browser.

Viewing Project Information
Resources might want to view the projects they are part of in the standard 
interface, as a way of setting context for their own tasks, checking on other 
dependent tasks, or keeping track of deadlines.

Viewing Project Overview
The Project Overview page displays a wide range of information about a 
particular project, including the project’s name, status, percent complete, 
manager, and plan period. All of this data and more is presented and arranged 
through the following sections of the Project Overview page:

Work Plan Section. This section of the Project Summary tab on the 
Project Overview page displays the top-level tasks of the project work plan 
Gantt chart. See Viewing the Project Gantt Chart on page 163.

Milestones Section. This section of the Project Summary tab on the Project 
Overview page lists the milestones in a work plan. See Viewing Project 
Milestones on page 164.

Project Control Item Sections. These sections of the Project Summary tab 
on the Project Overview page display summaries of issues, risks, or scope 
changes that have been submitted for the project. See Viewing Project 
Control Items on page 135 for more details.

Project Staffing Section. This section of the Project Summary tab on the 
Project Overview page displays links to a project’s staffing profiles. See 
Viewing Project Staffing on page 135 for more details.

Project Exceptions Tab. Shows the number and kinds of exceptions 
triggered and links to the Exception Details portlet. See Viewing 
Exceptions on page 161.

References Tab. Provides a list of all references linked to the project 
(requests, packages, tasks, other projects, releases, attachments, URLs) and 
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where in the project they are referenced from. See Viewing Project 
References on page 162.

Figure 8-1. Project Overview page: Summary tab

Users can access the Project Overview page through the Project Search page, 
as well as the Project List portlet, which is available for display on the 
resource’s PPM Dashboard. 

Viewing Exceptions
The Project Overview page’s Project Exceptions tab displays the exceptions 
that have been triggered for the project being viewed, breaking each triggering 
task down according to:

Exception type and number of days violated

Task status, resource, scheduled start and finish

Work plan path
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Figure 8-2. Project Overview page: Project Exceptions tab

This is useful for resources in that it provides specific context for every 
exception in a project, telling them what task has gone wrong (or what might 
go wrong, depending on the exception rules enabled), when it went wrong, and 
where the problem task is located. Additionally, for tasks that have a “No 
resources assigned” exception, the Project Exceptions tab allows you to open 
the work plan directly by clicking Assign.

Viewing Project References
The Project Overview page’s References tab displays all entities linked to the 
project as references. References (requests, packages, tasks, other projects, 
releases, attachments, and URLs) are listed with details including:

Reference Type

Description

Referenced By
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Figure 8-3. Project Overview page: References tab

The References tab provides a convenient single point of access for all entities 
referenced by a project.

Viewing the Project Gantt Chart
The Work Plan section of the Project Overview page shows the project work 
plan Gantt chart’s top-level tasks. Click Edit Work Plan to view the work plan.

Figure 8-4. Project Summary tab: Work Plan section

If you do not have the access required to edit the work plan, the button will be labeled 
View Work Plan.
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Viewing the Critical Path
The critical path of a work plan is made up of the tasks that define its duration. 
A work plan’s critical path can be displayed in the Schedule view for a project. 
See Viewing the Project Critical Path on page 128 for more details.

Viewing Project Milestones
Milestones are used to mark significant events in a work plan, often the 
completion of a deliverable or arrival of a deadline. In the work plan Gantt 
chart, milestones appear as black diamonds.

Milestones are also listed in the Milestones section of the Project Overview 
page.

Figure 8-5. Project Summary tab: Milestones section

Viewing Resource Information
Resources can view information on their current assignments using the View 
Resource page. The View Resource page includes the Capacity/Load tab, 
which displays a chart of resource capacity and a customized Gantt chart 
illustrating their assignments for the next two weeks, or a time period of their 
choosing.

To access your own View Resource page, select Administration > View My 
Resource Information from the menu bar.

Project managers with the proper level of access can also view information on 
resources including their workload capacity.

Figure 8-6 illustrates the Capacity/Load tab of the View Resource page.
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Figure 8-6. View Resource page: Capacity/Load tab

To open the View Resource page, select Resource Management > Resources > 
Search Resources from the menu bar. Provide any search criteria in the Search 
Resources page and click Search.

Exporting Your Task Schedule
HP Project Management allows you to view and filter the project work plan to 
display only the tasks assigned to you, which you can then export to a PDF file 
for your own use. In order to view and filter the work plan, you must have a HP 
Project Management license, meet the project’s participant restrictions as 
defined in the Project Security policy, and have the View Projects access grant 
at a minimum. Project managers may want to perform this action for resources 
that lack the proper level of access.

To obtain a PDF file of project tasks assigned to you:

1. Log on to PPM Center.

2. Open the project to edit.

For more details on searching for and opening projects, see Searching for 
Projects on page 131.

3. On the Project Overview page, click Edit Work Plan.

The Work Plan page opens.
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4. Click the All Tasks button next to Filter for and select Tasks by resource.

The Filter Options dialog box opens.

5. Select your own name from the resource field and click OK.

The Work Plan page reloads, displaying only tasks assigned to you.

6. Click the PDF icon.

The PDF Export Options dialog box opens.

7. Select the desired options for the display of the project Gantt chart, the 
included columns, and paper size.

8. Click Export.

The filtered project PDF file opens in a new window, where it can be 
viewed and saved.

Updating Tasks
HP Project Management makes it easy for resources to report on different 
aspects of tasks in multiple levels of detail:

Using the My Tasks Portlet

Actuals for multiple tasks can be updated simultaneously, with information 
deemed essential by the project manager available to update immediately.

Using the Task Page

Resources can view their tasks in detail, updating and saving task notes and 
references.

Updating task actuals can trigger events in the project that move it along its 
path to completion.

If HP Time Management has been enabled for a project, you may not be able to enter 
Actual Effort values for tasks whose actuals are expected to be entered through HP 
Time Management time sheets. These tasks are marked with an icon resembling a 
clock.
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Using the My Tasks Portlet
Sometimes it might be necessary for a resource to only update a specific task 
detail, such as the % Complete. The My Tasks portlet is perfectly suited to this 
need, and has the added advantage of being able to show multiple tasks at 
once.

The fields collected by the portlet are determined by the fields tracked by the 
project, which are controlled through different policies in the project settings. 
See Chapter 3, Configuring Project Types, on page 35 for details.

The My Tasks portlet displays information for multiple tasks. The maximum 
number of tasks displayed can be specified by the user, as well as the portlet 
title. Most fields in the My Tasks portlet are updateable by resources.

The My Tasks portlet integrates with HP Time Management to allow you to 
update task actuals using time sheets. See Chapter 11, Integration with HP 
Time Management, on page 209, for more detailed information on Time 
Management integration.

To update fields in the My Tasks portlet:

1. Make the update in the desired field.

2. Click Save.

To clear all changes and reset all fields to their previous values, click 
Reset.

Getting to the My Tasks Portlet

The My Tasks portlet is defaulted to display on a resource’s home page. The 
home page can be reached at any time by selecting Dashboard > Front Page 
from the menu bar at left.

Integration with HP Time Management

HP Time Management allows you to enter actual effort values on a more 
granular level using the My Tasks portlet, which interfaces with time sheets. 
General considerations when using the Time Management integration include:

The My Tasks portlet creates time sheets or time sheet lines for you as 
needed.

In order for updates to take effect, the participant must click Save. Only then will 
HP Project Management take into account the updates that have been made.
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Ensure that you have selected the correct period for which to enter time in 
the Use Time Sheet field before entering time.

Clicking the Actual Effort value opens the Effort Breakdown dialog box, 
which allows you to edit entries for the associated time sheet lines.

Once you have created a time sheet entry for a task, the time sheet data 
controls the task’s actual start and finish dates.

Time can be tracked for summary tasks, which are visible in the My Tasks 
portlet when the project tracks time at this level. Individual tasks are also 
visible, but without actual effort, allowing you to indicate progress toward 
specific deliverables, independent of effort.

For more information on this integration, see Chapter 11, Integration with HP 
Time Management, on page 209.

Using the Task Page
The Task page contains detailed information on multiple aspects of a single 
task. Notes and references for a task are updateable through the Task page by 
the following sets of users:

Users with the Edit Projects access grant

Users with the Update Tasks access grant who have been assigned to the 
task

To update notes or references in the Task page:

1. Open the task using one of the methods described below:

Searching for Tasks and Projects on page 157

Finding Tasks Using the My Tasks Portlet on page 156

Finding Tasks Using Notifications on page 160

The Task page opens.

2. Make the desired update to the task’s Notes or References.

For details on adding references to a task, see Viewing and Modifying 
References on page 169.

3. Click Save.
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Viewing and Modifying References
HP Project Management features a number of methods for capturing additional 
information, or references, related to your projects. Tasks can include 
references to other entities or points of information, allowing easy access and 
visibility to data related to the current project. The following references can be 
attached to a task:

URLs

Attachments (anything that can be placed on a server: PDF files, JPEG 
images, Java™ .class files, and so forth)

Requests

Packages

Tasks

Other projects

Releases

Task references are attached from the Task page. Project managers can add 
references at the project level through the References tab of the Project 
Overview page.

Adding References to Tasks
You can reference a Web accessible file or attach a file from your local 
machine to the current task.

Attaching Files

To add a file as a reference:

1. Navigate to the Task page and scroll down to the References section.

2. Select Attachment from the New Reference field.

3. Click Add.

The Add Document page opens.
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4. Select the desired file from your machine and type a description if desired.

5. Click Add to add the selected attachment as a reference.

The referenced attachment appears in the References to be added on Save 
list on the Task page. The reference has not been added yet.

6. Click Save to add the attachment to the task.

Attaching URLs

To add a URL as a reference:

1. Navigate to the Task page and scroll down to the References section.

2. Select URL from the New Reference field.

3. Click Add.

The Reference URL page opens.

4. Type the URL into the URL field and type a description if desired.

5. Click Add to add the specified URL as a reference. 

The referenced URL appears in the References to be added on Save list on 
the Task page. The reference has not been added yet.

6. Click Save to add the reference to the task.
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Viewing and Editing References
You can view the references that have been linked to a task. The references are 
listed in the References section of the Task page.

To view the references currently linked to the task:

1. Navigate to the Task page and scroll down to the References section.

2. Click on the name of the reference you want to view.

If the reference is a URL, it opens inside your Web browser.

If the reference is a file of any other kind, it is handled by your Web 
browser in the usual fashion, either opening directly or asking to be 
saved to your local machine.

If the reference is a project, its Project Overview page opens, 
displaying summary information related to that particular project.

If the reference is another PPM Center entity (request, package, or task) 
it will open the entity’s Details page.

If you have permission to edit the task, you can modify the task’s references. In 
addition to adding new references, you can delete and change the relationships 
of existing references.

You can also view references related to your tasks and projects using the 
References tab on the Project Overview page.

If you have licenses for HP Demand Management and HP Deployment Management, 
you can click the request or package to access their detail pages. You can then 
update those entities according to normal PPM Center operation. 
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Figure 8-7. Project Overview page: References tab

Deleting References
If you have permission to edit the task, you can delete the task’s references. 

To delete a task reference:

1. Navigate to the Task page and scroll down to the References section.

2. Click the Delete icon to the left of the reference.

A message will appear asking you to confirm the deletion. 

3. Click Yes.

The reference is removed from the task.
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9 Using Work Plan Templates

In This Chapter:

Setting up a Work Plan Template
Creating and Managing Work Plan Templates
Adding Tasks to a Work Plan Template
Configuring Tasks in a Work Plan Template
Configuring Access to a Work Plan Template

Creating a Work Plan Template from an Existing Work Plan
Work Plan to Work Plan Template Conversion Details

Creating a Work Plan from a Work Plan Template
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Setting up a Work Plan Template
Work plan templates are used in HP Project Management to create repeatable 
processes to be used as a model and basis for numerous projects.

Work plan templates speed up the process of setting up your work plans. A 
repeated set of tasks are bundled into a template and used to create a work plan 
while preserving its notifications, any resource assignments, and predecessors.

For example, a company with several different software products might use the 
same process for all development efforts. A work plan template could be used 
to create the work plan for each one, as opposed to creating them all 
individually every time a project is planned. Information for each individual 
project can then be modified by a particular project manager as needed.

A work plan template consists of an ordered hierarchy of tasks. The sequence 
of tasks can be edited in a manner nearly identical to the way work plans are 
manipulated in the Schedule view.

Figure 9-1. Defining a work plan template

Creating and Managing Work Plan Templates
Work plan templates are created and managed from the 
Administration > Project Types & Templates menu group in the menu bar.

To create a work plan template, click Administration > Project Types & 
Templates > Create Work Plan Template. The Create Work Plan Template 
page opens, allowing you to create a work plan template.

To manage work plan templates, click Administration > Project Types & 
Templates > Manage Work Plan Template. The Manage Work Plan 
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Template page opens, listing all the work plan templates in the system. 
Click on a work plan template name to open the Template Details page.

Adding Tasks to a Work Plan Template
After you create a work plan template, the Work Plan Template page opens. 
The process of adding tasks to a work plan template is identical to adding tasks 
in the Schedule view. See Adding Tasks to the Work Plan on page 68 for 
details.

Configuring Tasks in a Work Plan Template
Tasks and notifications in a work plan template can be configured the same 
way as they are in the Schedule view. See Editing Task Information on page 95 
for details.

You can mark a task in a work plan template as required. A required task 
cannot be renamed or removed from a work plan created using the template. 
To mark a task as required, select the Require this task on work plans created 
from this template checkbox in the Task Details page.

Configuring Access to a Work Plan Template
You can control who has the ability to use or edit a work plan template through 
the Configure Access page. Click Configure Access in the Template Details 
page to configure access for a work plan template.

Some fields in work plan template tasks do not exist or cannot be updated.

Some fields in work plan template tasks do not exist or cannot be updated.
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Creating a Work Plan Template from an Existing Work Plan
Project managers can create a new work plan template from an existing work 
plan. Project managers who want to convert their Microsoft Projects into HP 
Project Management work plan templates can first import their Microsoft 
Project into a HP Project Management project and then convert it into a 
template. See Integrating Project Management with Microsoft Project 
on page 179 for detailed instructions on converting a Microsoft Project file 
into a PPM Center project.

To create a work plan template from an existing work plan:

1. Open the project.

2. In the Schedule view, click Actions and select Convert Work Plan to 
Template.

The Convert a Work Plan to a Template dialog box opens.

3. Provide a new Template Name, Template Owner and Description for the 
new work plan template.

4. Select whether to include Notifications by selecting the associated 
checkbox.

See Work Plan to Work Plan Template Conversion Details for a list of 
items copied from the work plan to the template.

5. Click Convert.

When the conversion is complete, a dialog box opens.

Only users with the Edit Work Plan Templates access grant can convert an existing 
work plan into a work plan template.

In order to successfully convert a work plan to a template, you must be the only user 
editing the work plan. If other users are editing the work plan, a message will appear 
stating that the “Project is being edited by another user” and the conversion stops. 
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6. Click Edit Template to edit the new work plan template.

Work Plan to Work Plan Template Conversion Details
When creating a work plan template from a work plan, the following items are 
copied or dropped:

Data that work plan templates do not carry is dropped. This includes:

External predecessors

Schedule dates

Constraints

Effort and cost actuals

Task status

Resource assignments and summary task owners

References

Notes

User data

Scheduled effort is copied as follows:

For automatically-calculated tasks, scheduled effort is recalculated.

For manually-input tasks, total task effort is retained in the Unassigned 
Effort field.

Everything else is copied into the work plan template.

In the work plan to template conversion, not all work plan details are copied to the new 
template. The work plan’s actuals information is discarded during the conversion, 
such as the actual duration, efforts, start date and end date of the work plan and 
tasks.
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Creating a Work Plan from a Work Plan Template
If a company has a business process that is used repeatedly, it will be easier to 
create and manage if it has its own template containing preconfigured settings. 

To create a new work plan from a work plan template:

1. Create a new project.

2. On the Project Overview page, click the Create work plan from a template 
link.

The Create Work Plan from Template dialog box opens.

3. Select the desired template from the Work Plan Template field.

4. Click Create.

A new work plan is created as defined by the work plan template.

The project type may enforce a particular work plan template for a project. See Work 
Plan on page 40 for more details.
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10 Integrating Project Management with 
Microsoft Project

In This Chapter:

Overview of Integrating Project Management with Microsoft Project
Synchronization Modes
Project Management Strategies

Installing the Plug-in for PPM
Requirements for the Plug-in for PPM
Installation Instructions

Sending a Microsoft Project Work Plan to Project Management
Opening a Project Management Work Plan in Microsoft Project
Setting a Synchronization Mode for Project Management and Microsoft Project

Sending Work Plan Information from Microsoft Project to Project Management
Retrieving Actuals from Project Management
Enabling Detailed Synchronization Logs
Mapping Resources Between Applications
Errors and Warnings

Removing Microsoft Project and Project Management Associations
Project-Level Settings for Integration

Integration Mode
Transferring PPM Center Information to Microsoft
Microsoft Storage Location for PPM Center System Information
Disabling Save Prompting

Impact of Microsoft Project Rules on Fields
Solutions for Project Managers

Conditional Editing Allowed In Project Management
Editing Project Management Controlled Projects
Editing Microsoft Project Controlled Projects
Editing in Shared Control Mode
Conditional Editing Summary Table

Working with Projects Using a Microsoft Project Server
Troubleshooting

Deleting Required Tasks or Tasks with Actuals
Cost Rollup and Health Calculations
Resource Calendars
Units
Microsoft Project’s Manual Scheduling Mode
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Overview of Integrating Project Management with Microsoft 
Project

HP Project Management integrates with Microsoft Project using the Plug-in 
for PPM. The integration between Microsoft Project and Project Management 
allows the organization to have visibility into projects even when their 
schedules are planned in Microsoft Project. The integration allows project 
managers to import project information from Microsoft Project to a new HP 
Project Management project. Project information can also be exported from 
Project Management to Microsoft Project, creating a new project in Microsoft 
Project. Projects that have been imported or exported can be synchronized. 
Any information that is shared between projects in both applications is updated 
during synchronization.

Depending on your project management strategy, you can use each application 
to accomplish different vital tasks; a general outline of the most common way 
to use the integration follows below.

1. Before you can use the integration, your system administrator needs to 
verify or adjust some key settings to conform to your organization’s 
business needs. You should not use the Microsoft Project integration until 
this has been completed.

For more detailed information, see the HP Project Management 
Configuration Guide.

2. In order to use the integration, you must download and install the Plug-in 
for PPM from HP Project Management, accessible at any time from the 
menu bar.

Once the plug-in is installed, Microsoft Project can be used to work with 
Project Management work plans in any of the ways described below. For 
detailed instructions on the Plug-in for PPM, see Installing the Plug-in for 
PPM on page 185.

3. Decide how you will manage your plan.

See Synchronization Modes on page 181 for details on the different 
synchronization modes offered by the integration.

The Plug-in for PPM is only compatible with Microsoft Project 2000 (SP1), 2002, and 
2003. It is not compatible with earlier versions of Microsoft Project such as Project 
Central. 

If the plug-in has not been installed on your system and you cannot see the download 
option in the menu bar, contact your PPM Center administrator for access.
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The relevant settings for the project should be configured based on your 
preferences. See Project-Level Settings for Integration on page 196 for 
more detailed information.

4. Decide how you want to create the work plan.

See Project Management Strategies on page 183 for details on different 
ways to create and maintain a work plan.

5. Create and manage the work plan.

If your work plan is Project Management-controlled, you will create 
the work plan in Project Management and occasionally open it in 
Microsoft Project. See Opening a Project Management Work Plan in 
Microsoft Project on page 189 for more detailed information.

If your work plan is Microsoft Project-controlled, you will create the 
work plan in Microsoft Project and occasionally open it in Project 
Management. Mapping of resource information between applications 
occurs automatically when sending a Microsoft Profile file to Project 
Management, but you can make manual adjustments during the 
process. See Sending a Microsoft Project Work Plan to Project 
Management on page 188 for more detailed information.

If control is shared, you will manage the work plan in Microsoft Project 
and collect actuals using Project Management. See Setting a 
Synchronization Mode for Project Management and Microsoft Project 
on page 190 for more detailed information.

Synchronization Modes
By synchronizing information between Project Management and Microsoft 
Project, you have the advantage of using the “best of both possible worlds.” 
Depending on your project management strategy, you can use one application 
to perform all planning and tracking activities, and then use the other for 
publishing project information to managers, participants and stakeholders, or 
use both to share control of different aspects of the project. See Project 
Management Strategies on page 183 for more information about different 
project management strategies.

The project manager can select from three synchronization modes for updating 
information between Project Management and Microsoft Project. Each mode 
offers a different strategy for communication between the two applications and 
has its own set of advantages.
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Project Management Controlled

The project manager initially creates a work plan in Project Management to 
perform planning and tracking activities. These activities include defining the 
project, scheduling tasks and tracking actuals. The first time the project is 
synchronized, Project Management creates a new project file on the project 
manager's desktop computer. For each subsequent synchronization, all of the 
information in the Microsoft Project file is replaced with the current 
information in Project Management.

Even if you want to manage your work plan using Project Management, you 
can create it initially in Microsoft Project.

After synchronization, the project manager can distribute the Microsoft Project 
file or use it to run reports for managers and other people in the organization. 

Microsoft Project Controlled

The project manager creates a project in Microsoft Project to perform project 
planning and tracking activities and then publishes it to Project Management, 
where the synchronized project appears on the PPM Dashboard. Information 
unique to PPM Center can be added within Project Management, such as 
notifications, task notes, or references to related entities within PPM Center. 
These references can provide information back to the project manager.

For all subsequent synchronizations, information in Project Management is 
updated with current information from Microsoft Project. Information added in 
Project Management, such as notification configurations or activity or role 
associations, is retained.

Shared Control

The project manager plans and schedules the project in Microsoft Project while 
using Project Management to track actuals. Participants in the project directly 
report actuals data using the My Tasks portlet or a time sheet. Each subsequent 
synchronization updates the Microsoft Project file with actuals data from 
Project Management. The Project Management work plan is updated with 
changes to its structure or schedule in Microsoft Project.

See Setting a Synchronization Mode for Project Management and Microsoft 
Project on page 190 for more information about synchronization.
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Project Management Strategies
The following scenarios demonstrate how project managers can use different 
project management strategies offered by the integration.

Publishing a Project Management Work Plan through Microsoft Project

A project manager who uses Project Management to manage projects can use 
the integration to publish the projects. Publishing can simply mean distributing 
the Microsoft Project file to external audiences (such as a Program 
Management Office group). Publishing could also mean synchronizing the 
Microsoft Project file with Project Management, and then running Microsoft 
Project reports for distribution. The projects can be published on a regular 
basis (weekly or quarterly) or at defined milestones (such as design 
completion).

To publish a Project Management work plan through Microsoft Project:

1. Open a blank file in Microsoft Project.

2. Open the Project Management work plan in Microsoft Project. (See 
Opening a Project Management Work Plan in Microsoft Project 
on page 189 for detailed instructions.)

3. Save the project and run reports as usual.

After the first export, you may choose to synchronize the Project Management 
work plan with the Microsoft Project file in Project Management Controlled 
mode. This will effectively regenerate the Microsoft Project file.

This can also be used to recover a lost Microsoft Project file from a 
previously-synchronized Project Management work plan.

Publishing a Microsoft Project File through Project Management

A project manager who uses Microsoft Project to manage projects can publish 
those projects using Project Management. You can create a work plan in 
Project Management from a work plan template and subsequently open it in 
Microsoft Project for further editing. This allows you to take advantage of any 
standards enforced by a PMO. Publishing means loading the project data into 
the Project Management repository, which has the following benefits:

The project status appears in the PPM Dashboard. Project Management 
calculates exceptions and health status (red/yellow/green) based on the 
project’s policy settings.

Project participants and external audiences can see the project in various 
interfaces such as the My Tasks portlet and search pages. Although these 
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participants cannot use Project Management to update project status, this is 
an effective way to increase visibility of project information.

Project Management users can create references from other PPM Center 
entities (such as requests and packages) to tasks in the synchronized 
project. These references could be used to monitor the state of a particular 
task.

To publish a Microsoft Project file through Project Management:

1. Create a project in Project Management without a work plan.

2. Ensure that the project’s integration mode is set to Microsoft Project 
control.

3. Send the Microsoft Project file to Project Management. (See Sending a 
Microsoft Project Work Plan to Project Management on page 188 for 
detailed instructions.)

The project manager is likely to publish the project to Project Management on 
a regular basis. This can be done by selecting PPM > Update Associated Work 
Plan in Microsoft Project. Information in Project Management is updated 
based on the information in the Microsoft Project file, and information unique 
to Project Management is retained.

Using Both Applications to Track Different Project Data

A project manager who uses Microsoft Project to plan and manage projects can 
use Project Management to collect actuals from participants. In addition to the 
benefits described previously in Publishing a Microsoft Project File through 
Project Management, this integration shifts some of the effort of collecting and 
entering actuals information from the project manager to the participants. The 
project manager will need to synchronize the projects periodically, either to 
publish a re-planned work plan to Project Management or to collect new 
actuals updates into Microsoft Project.

To use Project Management to track actuals from Microsoft Project:

1. Create the work plan.

You can create the work plan initially in Microsoft Project and 
subsequently send it to Project Management in order to establish the 
work plan integration. All work plan editing should still be done in 
Microsoft Project.

You can also create the work plan initially in Project Management 
using a work plan template and subsequently edit it in Microsoft 
Project. This allows standards to be enforced even when using 
Microsoft Project for work plan management.
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2. From the PPM menu in Microsoft Project, select Update associated work 
plan.

The Update Associated Work Plans dialog box opens.

3. Select Send work plan information from MSP to PPM or Retrieve actuals 
from PPM to MSP and click OK.

See Setting a Synchronization Mode for Project Management and Microsoft 
Project on page 190 for more detailed information.

Installing the Plug-in for PPM
To integrate Microsoft Project and Project Management, you must download 
and install the Plug-in for PPM from the menu bar. This is a one-time action 
that does not need to be repeated every time you use Microsoft Project or 
Project Management.

Before installing the plug-in, open Microsoft Project. If you see a PPM menu at 
the top of the window, then the plug-in has already been downloaded and 
installed for you.

Requirements for the Plug-in for PPM
The following are the Project Management and Microsoft Project requirements 
that should be met before installing the plug-in.

Microsoft Project Requirements

The Microsoft Project requirements for the plug-in are:

You must have access to your local PC that allows you to install software.

You must be using Microsoft Project 2000 (SP1), 2002, or 2003.

Microsoft Project must be installed on the workstation.

The saved project file must either be on the workstation, or on a mapped 
network drive.

If the plug-in has not been installed on your system and you cannot see the download 
option in the menu bar, contact your PPM Center administrator for access.
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Access Grants

In order to install and use the plug-in, you need a HP Project Management 
license and the Synchronize Work Plans access grant. This access grant is 
included in the PPM Project Manager security group included with HP Project 
Management. 

Installation Instructions
To integrate PPM Center with Microsoft Project, the Plug-in for PPM must be 
installed. If you have the proper level of access to your workstation, you can 
install the plug-in yourself. Alternatively, your system administrator may 
install the plug-in at the server level, and then use a technology such as 
Microsoft SMS to push it to client machines. Program managers can also 
install the plug-in on client machines.

This section provides the steps you perform to install the plug-in.

To install the plug-in:

1. If Microsoft Project is open, exit Microsoft Project.

2. After you install and configure PPM Center, log on to PPM Center.

3. From the menu bar, select Administration > Download Microsoft 
Project Plugin.

The File Download dialog box opens and prompts you to indicate whether 
you want to open or save the setup.exe file. 

4. Click Open. 

The Plug-in for PPM Install Shield wizard starts up.

5. On the Welcome page, click Next.

The Destination Folder page displays the default directory for the 
plug-in installation.

6. To accept the default directory, click Next. Otherwise, change the install 
directory, as follows:

a. Click Change.

The Change Current Destination Folder page opens.

b. Browse to, and then select a destination installation folder.

c. Click OK.
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7. Click Next.

The Server URL Default page opens.

8. In the Project Portfolio Management Server URL field, type the first part of 
the URL for the PPM Server. 

Allowed formats include:

<server:port>

http://<server:port>

https://<server:port>

For example, if your URL is:

http://myserver:41000/itg/dashboard/app/portal/PageView.jsp

Then you can enter:

http://myserver:41000

or

myserver:41000

9. Click Next.

10. Click Install.

11. After installation is completed, on the InstallShield Wizard Completed 
page, click Finish.

The next time you start Microsoft Project, the menu bar includes the 
PPM menu.

You can uninstall the plug-in using your workstation’s standard Add/
Remove Programs utility. Microsoft Project should be closed during this 
operation.

If you do not know the default URL, you can provide this information later, after 
you install the plug-in.
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Changing the PPM Server URL Setting

If, after installing the Plug-in for PPM, you must change the server URL, you 
can make the change in the ITGovernance.ini file found in the plug-in’s 
install directory using a text editor. This file will retain the last server URL you 
used. You can also clear the server URL setting using the PPM menu in 
Microsoft Project.

To change the server URL setting

1. From the Microsoft Project menu bar, select PPM > Clear Server Default.

2. The next time you attempt to connect to PPM Center, you will be prompted 
to provide a new server URL.

Sending a Microsoft Project Work Plan to Project Management
A project manager who uses Microsoft Project to manage projects can publish 
those projects using Project Management. Use the Send work plan to PPM 
option in the PPM menu in Microsoft Project to create a new work plan in 
Project Management based on the current .mpp file in Microsoft Project. This 
option can be used regardless of how the plan will be managed after its 
creation. Projects using Microsoft Project Server behave somewhat differently; 
see Working with Projects Using a Microsoft Project Server on page 205.

To send a Microsoft Project work plan to Project Management:

1. From the Microsoft Project menu bar, select PPM > Send work plan to PPM.

2. Type your Project Management username and password.

3. Select a project to send the Microsoft Project work plan to.

You can only select from projects that do not have work plans, and only for 
projects for which you are the project manager. If no such project exists, 
you must create one first in Project Management.

4. Click Send.

You need to create a project without a work plan in Project Management before 
importing the file from Microsoft Project.
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5. Specify mapping for unmapped resources, if any.

The integration automatically performs resource mapping between 
applications, but you can make changes manually as described in Mapping 
Resources Between Applications on page 194.

6. Click Done.

You can also click Show Info to view the information dialog box to view 
any informational messages, errors, or warnings that occurred while 
sending the work plan to Project Management.

Whenever you send a Microsoft Project file to Project Management, a 
backup copy of the .mpp file is automatically saved to the same directory in 
which the original file is stored, with the extension .bak.

Opening a Project Management Work Plan in Microsoft Project
A project manager who uses Project Management to manage projects can open 
a Project Management work plan in Microsoft Project. The manager can then 
distribute the Microsoft Project file to external audiences (such as a PMO 
group). The manager could also synchronize the Microsoft Project file with 
Project Management periodically, and run Microsoft Project reports for 
distribution.

For more information on synchronizing your Project Management work plan 
with its Microsoft Project counterpart, see Setting a Synchronization Mode for 
Project Management and Microsoft Project on page 190.

To open a Project Management work plan in Microsoft Project:

1. From the Microsoft Project menu bar, select PPM > Open a PPM work plan.

2. Type your Project Management username and password.

3. Select a work plan to open.

You can only select from projects that have active work plans. 
Additionally, the system will indicate whether the work plan you have 
chosen has already been integrated with Microsoft Project.

You can only open a Project Management work plan in Microsoft Project if you have a 
new, blank file open in Microsoft Project.
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4. Click Done.

You can also click Show Info to view the information dialog box to view 
any informational messages, errors, or warnings that occurred while 
opening the work plan in Microsoft Project.

The task structure and task names for the project in Project Management and 
the project in Microsoft Project will be identical. There will be a 1-to-1 
relationship between tasks, and tasks will appear in the same sequence in both 
projects. Tasks are marked as fixed duration, which causes resource 
assignments and efforts to match. Scheduled start and finish dates for tasks 
without actuals will be identical in Project Management and Microsoft Project.

Duration is calculated by Microsoft Project based both on the start and finish 
dates and the resource calendars in Microsoft Project. Task durations and 
rollup durations will sometimes differ slightly between the two applications.

Regional calendar settings applied to the project calendar in Microsoft Project 
include:

Number of hours per day

Working days for each week

Since calendar exceptions are not synchronized, variances in duration may 
result.

Setting a Synchronization Mode for Project Management and 
Microsoft Project

Control of projects that have been created in one application and opened in the 
other can be subsequently shared between Microsoft Project and Project 
Management using one of three modes defined by Project Management. These 
control modes are established on the Project Management side, in the Microsoft 
Project Integration policy in the project settings. See Project-Level Settings for 
Integration on page 196 for details on its settings.

Project Management controlled. Selecting PPM > Update associated 
work plan in Microsoft Project completely refreshes the plan information in 
Microsoft Project with the work plan from Project Management.

Microsoft Project controlled. Selecting PPM > Update associated work 
plan in Microsoft Project completely refreshes the plan information in 
Project Management with the work plan from Microsoft Project. Any 
additional edits made in Project Management are retained (see Conditional 
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Editing Allowed In Project Management on page 202 for details). If the 
Microsoft Project work plan includes resources that cannot be mapped to 
resources in PPM Center, you will be asked to map these resources. See 
Mapping Resources Between Applications on page 194 for more details.

Whenever you send a Microsoft Project file to Project Management, a 
backup copy of the .mpp file is automatically saved to the same directory in 
which the original file is stored, with the extension .bak.

If you originally created the work plan in Project Management using a 
work plan template, tasks marked as required by the template cannot be 
deleted in Microsoft Project. 

Shared control. Selecting PPM > Update associated work plan in Microsoft 
Project allows you to choose between the following options:

Sending updated schedule information from Microsoft Project to 
Project Management. If this option is chosen, the integration will 
refresh the work plan schedule information in the associated work plan 
in Project Management based on the data in Microsoft Project. Any 
additional edits made in Project Management are retained (see 
Conditional Editing Allowed In Project Management on page 202 for 
details). For more details on updating work plan information, see 
Sending Work Plan Information from Microsoft Project to Project 
Management. If the Microsoft Project work plan includes resources 
that cannot be mapped to resources in PPM Center, you will be asked to 
map these resources. See Mapping Resources Between Applications 
on page 194 for more details.

Whenever you send a Microsoft Project file to Project Management, a 
backup copy of the .mpp file is automatically saved to the same 
directory in which the original file is stored, with the extension .bak.

If you originally created the work plan in Project Management using a 
work plan template, tasks marked as required by the template cannot be 
deleted in Microsoft Project. Tasks that have actuals logged against 
them in Project Management cannot be removed from the Microsoft 
Project file. You must first remove the actuals if you intend to remove 
the tasks.

Retrieving actuals information from Project Management based on the 
settings described in Project-Level Settings for Integration 
on page 196. If this option is chosen, the integration will retrieve 
actuals data from Project Management for your review and optional 
application. For more details on obtaining actuals from Project 
Management, see Retrieving Actuals from Project Management.
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Sending Work Plan Information from Microsoft Project to Project Management
You can update your Project Management work plan to match the work 
breakdown structure, schedule, assignments, and actuals in the associated 
Microsoft Project file. For all subsequent synchronizations, information in 
Project Management is updated with current information from Microsoft 
Project.

To send work plan information from Microsoft Project to Project 
Management:

1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Update associated work 
plan.

The Update Associated Work Plans dialog box opens.

3. Select Send work plan information from MSP to PPM and click OK.

Automatic Backup of Microsoft Project Information

Every time work plan schedule information is successfully sent from Microsoft 
Project to Project Management, a backup copy of the .mpp file is automatically 
saved to the same directory in which the original file is stored, with the 
extension .bak. The open .mpp file is also saved.

When a work plan is being shared between Microsoft Project and Project 
Management, deleting one of the following types of tasks in Microsoft Project 
results in an error that will halt the next integration process:

A task marked as required by the work plan template, if the work plan was 
originally created in Project Management from a work plan template.

A task that has actuals.

If you experience an integration error related to the deletion of a task in 
Microsoft Project that had actuals, you can use the existing backup copy as a 
starting point from which to reapply your most recent edits.

Projects using Microsoft Project Server behave somewhat differently; see 
Working with Projects Using a Microsoft Project Server on page 205.
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Retrieving Actuals from Project Management
You can update the Microsoft Project file with actuals data retrieved from the 
associated Project Management work plan when Project Management and 
Microsoft Project share control of the plan. The integration will show you the 
tasks in the Microsoft Project work plan that will be updated with new actuals, 
and gives you the option of cancelling the update if the changes are not what 
you expected.

To update the Microsoft Project work plan with actuals from Project 
Management for a plan using shared control:

1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Update associated work 
plan.

The Update Associated Work Plans dialog box opens.

3. Select Retrieve actuals from PPM to MSP and click OK.

The integration retrieves the actuals specified in the Transfer actuals 
information setting in the Microsoft Project Integration policy.

The Accepting PPM Actuals dialog box opens, displaying the tasks that 
have changed and the nature of their changes. If the changes are not what 
you expected, you can click Cancel to cancel the update.

4. Click Continue.

The Microsoft Project work plan is updated with new actuals from Project 
Management, and a new table opens in Microsoft Project identifying both 
tasks whose actuals changed (changed tasks) as well as tasks whose 
schedule information changed as a result of Microsoft Project’s internal 
field rules (impacted tasks). See Impact of Microsoft Project Rules on 
Fields on page 200 for more detailed information.

By default, changed tasks are displayed in red, while impacted tasks are 
displayed in blue. These colors can be configured in the Microsoft Project 
Integration policy in the project settings. See Project-Level Settings for 
Integration on page 196 for details on its settings.

You can also use custom filters and data table views provided by the 
integration for Microsoft Project to view changed actuals. See Custom 
Microsoft Project Filters and Tables on page 201 for more details.

5. To return to the normal Gantt chart view in Microsoft Project, select 
View > Table > Entry.
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Enabling Detailed Synchronization Logs
By default, synchronizations between Project Management and Microsoft 
Project use the minimum amount of information tracing in order to optimize 
performance. You can choose to enable full information tracing for 
synchronizations, making detailed synchronization logs available from the Info 
tab of the Errors and Warnings window.

To enable full information tracing for a synchronization:

1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Enable all 
information-level tracing.

3. Begin the synchronization.

Mapping Resources Between Applications
In project planning, the concept of “resources” can have multiple definitions. 
A resource can be a team member, time on a mainframe computer, or 
construction materials. A resource in Project Management is a Project 
Management user capable of performing tasks. Resources are chosen from the 
staffing profile associated with the project or from the resource pools managed 
by the project manager. Microsoft Project supports tracking and costing of 
both human and material resources. Project Management supports only human 
resources.

A project can also contain resources that have not been assigned. In Microsoft 
Project, unassigned resources appear in some resource-centric project views 
but have little functional significance. In Project Management, unassigned 
resources are Project Management users listed in the staffing profile who have 
no task assignments.

During synchronization, all assigned human resources in Microsoft Project are 
first mapped automatically to defined users in Project Management. Automatic 
resource mapping is based on the following factors:

A match between the Microsoft Project resource name and the 
concatenation of the Project Management user’s first and last name.

A match between the Microsoft Project resource name and the 
concatenation of the Project Management user’s last and first name.

A match between the Microsoft Project resource name and the Project 
Management username.
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In general, the following should be taken into consideration:

In Project Management, the mapping does not guarantee that all assigned 
resources are part of the staffing profile. If the staffing profile needs to be 
maintained, then this must be done manually.

Material resources are not passed to Project Management.

Automatic resource mapping is not always 100% successful. The integration in 
Microsoft Project allows you to manually map resources across applications, 
or intentionally unmap resources that are irrelevant or have been erroneously 
mapped. This manual adjustment occurs as part of the synchronization process 
automatically.

To manually map resources from Microsoft Project to Project Management:

1. Perform synchronization as usual.

The Mapping MSP Resources to PPM Resources window opens at a 
certain point in the process.

Click Map to PPM Resource to locate a Project Management resource to 
map to a selected unmapped Microsoft Project resource.

Click Unmap to unmap a Microsoft Project resource.

2. Click Finish to proceed with the synchronization.

You can leave some resources unmapped. In this case, the effort 
associated with those resources will appear as unassigned effort on the 
task in Project Management.

You can map more than one resource in Microsoft Project to a single 
resource in Project Management. However, these Microsoft Project 
resources cannot both be assigned to the same task.

Errors and Warnings
During synchronizations, the Errors and Warnings window informs you of 
errors or warnings, and to include suggestions for resolving issues as they 
occur.

Errors are fatal problems that must be resolved for the task to be successful. 
Errors stop the integration process, allowing you to correct the problem and 
restart the integration.

Warnings are for informative purposes. After reviewing a warning, you 
may choose to respond to the warning or ignore it.
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Removing Microsoft Project and Project Management 
Associations

You can remove the association between a Microsoft Project file and a Project 
Management work plan at any time.

To remove the association:

1. Open the project in Microsoft Project.

2. From the PPM menu in Microsoft Project, select Project Details.

The HP Project and Portfolio Management Center Integration Details 
dialog box opens.

3. Click Remove Association.

If you have already removed the association, the button will be labeled 
Restore Association, which allows you to restore the association with the 
same Project Management work plan.

Project-Level Settings for Integration
There are a number of settings for projects in Project Management, which are 
determined by project policies. Project policies are inherited from the project 
type used to create a particular project. For more information on project types 
and policies, see Chapter 3, Configuring Project Types, on page 35. The 
settings that pertain to Microsoft Project integration are set by the Microsoft 
Project Integration policy.

You should only remove the association if you are sure you no longer need to link the 
Microsoft Project file to the Project Management project. Removing the link may make 
it impossible to re-associate the file.
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Figure 10-1. Microsoft Project Integration policy

To view or modify project settings for a project, do one of the following: 

From Project Management, click Project Settings from the Project 
Overview page.

Changes to the Microsoft Project Integration policy at the project type level do not 
propagate to projects of that type.
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From Microsoft Project, select PPM > PPM links > Settings: MSP 
Integration. This menu option is only available for projects that have been 
integrated.

Integration Mode
This setting determines which application has control over project information 
when synchronizing between Project Management and Microsoft Project.

If HP Project Management controls all shared work plan information, then 
any changes made in Microsoft Project are automatically discarded when 
project information is synchronized, as described in Publishing a Project 
Management Work Plan through Microsoft Project on page 183.

If Microsoft Project controls all shared work plan information, then work 
plan fields in Project Management are not editable, as described in 
Publishing a Microsoft Project File through Project Management 
on page 183.

If control is shared, then work plan information is determined by Microsoft 
Project, while actuals data is gathered by Project Management, as 
described in Using Both Applications to Track Different Project Data 
on page 184.

Transferring PPM Center Information to Microsoft
When transferring information from Project Management to Microsoft Project, 
you need to specify how resources are identified in Project Management using 
the Resource name is done based on setting, so the Microsoft Project 
integration can create them correctly in Microsoft Project.

If you wish to track actuals for your project in Microsoft Project, select the 
Transfer actuals information setting to enable the transfer of necessary data. 
This setting is used in shared control mode, and any time a Project 
Management work plan is used to create a new file in Microsoft Project.

The options for the Transfer actuals information setting function as follows:

Percent Complete. Using this option, the only actuals information passed to 
Microsoft Project is the task-level percent complete. Microsoft Project will 
imply the actual efforts and dates for each resource.

While it is possible to switch modes during project execution, it is not recommended 
unless you are moving to Project Management control.
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Percent Complete and Actual Dates. Using this option, the only actuals 
information passed to Microsoft Project are described below. All values are 
passed at the task level, and Microsoft Project applies data to assignments 
using its internal rules.

Actual start. Applying the actual start date to the task will move the 
scheduled start of the task in Microsoft Project and can have cascading 
impacts on the remainder of the schedule in Microsoft Project.

Actual finish (when available). Applying the actual finish date to the 
task will cause Microsoft Project to recalculate the task’s scheduled 
finish and duration, which can also cause recalculation of resource 
efforts and trigger cascading schedule changes throughout the plan.

Estimated finish (potentially). If the Estimated Finish field is being 
tracked in Project Management and no Actual Finish value exists, it will 
be passed to Microsoft Project as the scheduled finish for the task, 
which may have impacts on task duration, efforts, and schedule for the 
remainder of the plan.

Task-level percent complete. When the task-level percent complete is 
applied, Microsoft Project will imply resource level efforts.

Actual Efforts. Using this option, the only actuals information passed to 
Microsoft Project is the resource-level actual effort and estimated 
remaining effort. Microsoft Project will then infer the percent complete as 
well as actual start and scheduled finish dates. Since the effort may indicate 
the task will take more or less effort than intended, this can have cascading 
impacts throughout the plan, depending on the task setup in Microsoft 
Project. You should always track actual effort in Project Management 
when using this option. You can also optionally track estimated remaining 
effort.

Microsoft Storage Location for PPM Center System Information
The integration requires a custom Microsoft Project field for both tasks and 
resources in order to properly transfer information between applications. The 
first three settings in this category allow you to specify which field to use.

When synchronizing projects in shared control mode, several more custom 
Microsoft Project fields must be specified in this category. These fields hold 
the following: 

Snapshots of data that will be automatically changed by Microsoft Project 
once synchronization is complete
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Flags for fields that are changed by the synchronization, and fields that are 
changed by Microsoft Project based on those synchronized fields

This project-level setting also allows you to change the highlight colors in the 
custom Microsoft Project table view for synchronized actuals fields and the 
fields automatically changed by Microsoft Project based on the 
synchronization. For information on using this custom table view, see Custom 
Microsoft Project Filters and Tables on page 201.

Disabling Save Prompting
The HP Project and Portfolio Management Center Integration Details dialog 
box opened by selecting PPM > Project Details in Microsoft Project allows you 
to disable the message prompting you to send a work plan to HP Project 
Management whenever you save it in Microsoft Project.

Impact of Microsoft Project Rules on Fields
Microsoft Project maintains internal rules that determine the way field values 
are calculated in planning and actuals fields. These rules affect the 
synchronization processes between Microsoft Project and Project Management 
because calculations that work in one application do not necessarily carry over 
to the other application.

For example, Project Management allows you to retain actuals information that 
is completely separate from your schedule information. In Microsoft Project, 
this is not allowed, and making updates to one actuals field may trigger 
automatic revisions to other planning and actuals fields.

The most common Microsoft Project rules for planning and actuals fields are 
listed below.

Planning Fields

Start + Duration = Finish

Effort = Duration * (sum of resources * units)

Actuals Fields

Start = Actual Start (if known)

Finish = Actual Finish (if known)

Duration = Actual Duration + Remaining Duration

% Complete = Actual Duration / Duration
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Remaining Duration is zero when task is 100% Complete

Effort = Actual Effort  + Remaining Effort

% Work Complete = Actual Effort / Effort

When Project Management information is passed to Microsoft Project, 
Microsoft Project will always apply its standard rules. This will lead to 
situations where the data in each application does not match exactly.

Solutions for Project Managers
In order to give consistent behavior during synchronization, PPM Center 
project managers must:

Pay attention to fields that have changed. The integration provides a 
custom Microsoft Project table view that shows the user which fields have 
changed as a result of a synchronization, whether directly through the 
synchronization process, or indirectly as a result of Microsoft Project’s 
automatic calculations.

Synchronize these fields that are most important to your plan management 
by selecting the appropriate actuals integration option as described in 
Transferring PPM Center Information to Microsoft on page 198.

The integration ignores Project Management default values that are not 
enabled.

Custom Microsoft Project Filters and Tables

After synchronizing project information between applications, you can select 
from the following custom Microsoft Project items provided by the 
integration:

A filter named PPM: Changed Actuals

A filter named PPM: Dates Impacted by Changed Actuals

A data view table named PPM: Changed Actuals

These items enable you to quickly view the following:

Fields that have scheduled date changes as a result of the actual 
synchronization. These fields appear red by default.

Fields that have changed as a result of automatic calculations performed by 
Microsoft Project based on synchronized fields. These fields appear blue 
by default. This is useful for identifying any cascading impacts of a change 
in actuals.
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Conditional Editing Allowed In Project Management
Depending on the synchronization mode that has been selected for a project, 
the project structure and task information will be controlled by either Project 
Management or Microsoft Project. Depending on the synchronization control 
mode selected for the project, some editing features in Project Management 
will be disabled. Information controlled by Microsoft Project cannot be edited 
in Project Management.

Summaries of the conditional editing restrictions for each synchronization 
mode are listed in Conditional Editing Summary Table.

Editing Project Management Controlled Projects
When Project Management controls the project, the user is allowed to edit all 
information in Project Management. This includes changing the task structure, 
adding or deleting new subprojects and tasks, and editing task scheduling and 
actual fields. 

Editing Microsoft Project Controlled Projects
When Microsoft Project controls all the project planning and tracking 
activities, the comparable editing functions in Project Management are 
disabled. The data that is distinct to Project Management and not shared with 
Microsoft Project can still be edited. This includes task activity, role, skill 
values, description, user data, notifications, notes, and task references.

When working with a project type that enforces a particular work plan 
template, you can create the work plan initially in Project Management from 
the specified work plan template. You can then open the work plan in 
Microsoft Project.

Any function that could change the project and task structure is disabled in 
Project Management. This includes the following components:

Add Task icon

Delete icon

Indent/Outdent icons

Move up/Move down icons

Since scheduling can change dates and durations, the Schedule Project icon is 
disabled. The status of the PPM Center project cannot be changed in this 
synchronization mode; therefore the Change Status is also disabled. The key 
shortcuts for these icons are disabled as well.
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In the standard Project Management interface, the My Tasks portlet and the 
Task Detail page will not allow users to enter task actuals. The My Tasks 
portlets and the Task Search page still return the current incomplete tasks 
assigned to a user regardless of the control mode. This provides visibility to the 
project’s participants. The actuals collected in Microsoft Project are visible 
through the Work Plan page.

Rollup calculations are disabled through Project Management, whether 
triggered by actions in the PPM Workbench, the standard web pages, or any 
other method. Therefore, the rolled-up values in Project Management will 
match Microsoft Project even if Project Management’s calculations would 
normally produce a different value.

Editing in Shared Control Mode
The shared control mode is more complex than the other two modes when 
disabling fields. This mode allows users to change the actual fields while 
keeping the planning fields unchanged.

Only actual fields are editable, through the Resources tab on the Task Details 
page. The planning fields are disabled. In the Schedule view, planning fields in 
the subproject/task table are also not editable. 

Similar to the Microsoft Project control mode, any function that could change 
the project and task structure is disabled. This includes the following 
components:

Add Task icon

Delete icon

Indent/Outdent icons

Move up/Move down icons

Some rollup operations are disabled. Rollup of actuals fields still occurs, but 
schedule fields will not roll up. The imported values from Microsoft Project 
are retained. 

The functionality allowed in the Shared control mode is very similar to the 
functionality allowed to a user who has been given only the Update Tasks 
access grant.
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Conditional Editing Summary Table
Table 10-1 summarizes the allowed or restricted conditional editing in Project 
Management for each of the three synchronization modes.

Table 10-1. Conditional editing allowed in Project Management

 Fields in Project Management
Project 
Management 
controlled 

MSP controlled Shared Control Mode

Work Plan page

Add/Delete Task icon Yes No No

Indent/Outdent Task icon Yes No No

Move up/Move down Task icon Yes No No

Schedule Project icon Yes No No

Task Details page

Planning fields Yes No No

Actual fields Yes No Yes

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes

Other non-shared fields Yes Yes Yes

Status field Yes No Yes

Rollup

Schedule fields Yes No No

Actuals fields Yes No Yes

My Tasks portlet

Actuals fields Yes No Yes
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Working with Projects Using a Microsoft Project Server
When working with Microsoft Project Server-based project, HP Project 
Management functions slightly differently, in the following ways:

Work plans cannot be directly opened in Microsoft Project from HP 
Project Management.

After synchronizing a Microsoft Project Server-based project with a work 
plan, you will be prompted to check in the project into the Microsoft 
Project Server.

Troubleshooting
Microsoft Project supports many features that are not duplicated in or 
synchronized with Project Management. When a Microsoft Project file is 
imported into Project Management, this information is not represented. 
Sending a Microsoft Project file to Project Management does not remove this 
data from Microsoft Project. Opening a Project Management work plan in 
Microsoft Project does not create or default this data.

Other Microsoft Project features deal with the scheduling and tracking 
information that is synchronized between the two applications. In these cases, 
the interface converts the Microsoft Project data into information that Project 
Management can represent. The interface attempts to maintain the intent of the 
original work plan as closely as possible.

Deleting Required Tasks or Tasks with Actuals
Every time work plan schedule information is successfully sent from Microsoft 
Project to Project Management, a backup copy of the .mpp file is automatically 
saved to the same directory in which the original file is stored, with the 
extension .bak. The open .mpp file is also saved.

When a work plan is being shared between Microsoft Project and Project 
Management, deleting one of the following types of tasks in Microsoft Project 
results in an error that will halt the next integration process:

A task marked as required by the work plan template, if the work plan was 
originally created in Project Management from a work plan template.

A task that has actuals.

If you experience an integration error related to the deletion of a task in 
Microsoft Project that had actuals, you can use the existing backup copy as a 
starting point from which to reapply your most recent edits.
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Recovering Deleted Tasks Using Microsoft Project Associations

You can also relink the work plan to the Microsoft Project file manually by 
selecting PPM > Relink project in Microsoft Project. After you select the project 
whose link you want to reestablish, the integration examines the work plan task 
by task and presents you with a list of work plan tasks whose Microsoft Project 
counterparts are ambiguous or nonexistent. For each task, you can choose from 
the following options:

Select a matching task in the Microsoft Project plan

Create a new task in the Microsoft Project plan

Do nothing

Any tasks in the Microsoft Project plan that are not associated with an HP 
Project Management task are ignored.

Cost Rollup and Health Calculations
When sending information from Microsoft Project to Project Management, 
rollup of cost and health calculations is deferred in order to keep the 
synchronization process as efficient as possible.

Resource Calendars
The project regional calendar is exported to Microsoft Project in Project 
Management controlled mode or any time a Project Management work plan is 
used to create a new plan in Microsoft Project. Calendar hours-per-day and 
work days per week are exported, but calendar exceptions are not. 
Additionally, resource calendars are not synchronized between the two 
applications. Since both duration and effort are a function of both start/finish 
dates and resource calendars, the duration values in Project Management and 
Microsoft Project might not match. Since tasks in Microsoft Project are created 
as fixed duration in these cases, the total effort will match Project Management 
data.

Units
Units are also referred to as resource load percentages. In Microsoft Project, 
each resource can be assigned to a task with a different load percentage (from 
zero percent to one hundred percent.) For example, the same resource could be 
assigned to two different tasks and have a resource load percentage of fifty 
percent for each one.
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Since Project Management does not track assignment units, the load 
percentage of any resource imported into Project Management will not be 
recognized.

Microsoft Project’s Manual Scheduling Mode
If your Microsoft Project file is in manual scheduling mode and you did not 
select this option, it could be because:

The previous synchronization with Project Management failed. During 
synchronization, the scheduling mode is set to manual and then returned to 
automatic once the synchronization completes. If the synchronization did 
not complete, the scheduling mode may have been left in manual.

You opened a project that was in manual mode and then created the new 
Microsoft Project file. This caused the new project to inherit the manual 
mode setting as a default.
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11 Integration with HP Time Management 

In This Chapter:

Overview of HP Time Management Integration
Enabling Time Management for Projects
Using the My Tasks Portlet
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Overview of HP Time Management Integration
This chapter explains how HP Project Management integrates with HP Time 
Management to offer a more detailed way for resources to report time worked 
on projects. This chapter is only useful if you have purchased and installed HP 
Time Management.

In the project settings, you use the Cost and Effort policy (primarily its Time 
Management section) to integrate HP Time Management and HP Project 
Management for a particular project. There you specify:

At what level of detail the project’s tasks are tracked on time sheets

Who can log time for the project

Whether certain project representatives must approve time logged

Which effort fields are tracked

Whether time can be logged after a task is complete

In configuring integration, consider the following:

Any resource who is licensed for HP Time Management must use time 
sheets or the My Tasks portlet, rather than the project work plan, to enter 
actuals for integrated projects.

You can configure which actuals are tracked. For integrated projects, 
where HP Time Management is used to track project actuals, you must 
require resources to track Actual Effort. 

You can configure the level of the project (Project, Summary Task level 1 
to 6, or Task) against which resources log time. If time is logged at 
summary task level 2, for example, resources who are assigned to any tasks 
that are hierarchically under level 2 report time for those tasks only at 
summary task level 2.

If Estimated Remaining Effort is to be tracked, time must be logged at the 
task level.

After time is logged against an integrated project, you cannot change 
logging from any summary task level to the task level, nor from project 
level to the summary task level. However, you can change logging from 
the task level to the summary task level, or from the summary task level to 
the project level.

After time is logged against an integrated project, you cannot disable 
integration.
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Resources cannot contribute time to the same task from both HP Project 
Management and HP Time Management. Therefore, if you plan to 
establish integration for a project having tasks that are partially complete, 
first ensure that actuals are up to date, then divide each partially completed 
task into a completed task and a new task.

Some actuals fields that are updated by Time Management assignments are 
read-only on the Task Details page. Once effort has been entered by the 
assigned resource, only the assigned resource can delete it.

Time logged by assigned resources appear as contributions for tasks and 
summary tasks.

Managers of an integrated project do not necessarily need to assign all 
work plan tasks to Time Management users; actuals for Project 
Management users and unassigned effort will roll up automatically.

In addition to a Time Management section, the Cost and Effort policy also has 
a Resource Load Settings section and a Financial Management section. 

For information about the Resource Load Settings section, see Resource Load 
Settings on page 47.

In the Financial Management section, you can specify whether to use 
automatic cost calculation so that, whenever a resource updates and saves a 
time sheet, HP Time Management automatically passes the effort data to HP 
Project Management, which calculates and updates the Actual Cost for the 
project. (Then the Actual Cost cannot be edited directly in HP Project 
Management.) If you specify manual cost calculation, HP Time Management 
still passes effort data to HP Project Management, but HP Project Management 
does not calculate Actual Cost. For more information, see Financial 
Management on page 49.

The Project Fields policy determines whether Estimated Finish Date and 
certain other fields are tracked.

Enabling Time Management for Projects
The Cost and Effort policy determines whether Time Management is active for 
a given project type. Projects created using a project type with Time 
Management enabled will be able to use Time Management to collect actuals. 
For details on configuring the Cost and Effort policy to enable the use of Time 
Management, see Cost and Effort on page 45.
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Using the My Tasks Portlet
The My Tasks portlet displays information for multiple tasks. The maximum 
number of tasks displayed can be specified by the user, as well as the portlet 
title. Most fields in the My Tasks portlet are updateable by resources.

With Time Management enabled, the My Tasks portlet allows you to enter 
time using time sheets for projects using Time Management. Summary tasks 
also appear on the My Tasks portlet for integrated projects.

If you are working on a project that uses Time Management, the My Tasks 
portlet displays the Actual Effort field for each task as a calculated rollup of the 
effort breakdown, which corresponds to the time sheet indicated in the Use 
Time Sheet field, filtered for only the relevant tasks. Clicking the Actual Effort 
value opens the effort breakdown for direct editing. The effort breakdown 
displays only the tasks shown in the My Tasks portlet.

To enter actuals information for a project on a time sheet from the My Tasks 
portlet:

1. Navigate to the My Tasks portlet.

2. Ensure that the correct time sheet appears in the Use Time Sheet field.

If the time period being entered has no time sheet, you are offered the 
option to use a new time sheet, which will be created when Save is clicked.

Time sheets in the “In Rework” and “Pending Approval” status cannot be 
edited from the My Tasks portlet. Time sheets in the “Frozen” and 
“Closed” states do not appear in the list of available time sheets.

3. Click the Actual Effort value for the task you wish to enter actuals 
information for.

The Effort Breakdown dialog box opens.

4. Provide the information for the desired time sheet lines.

You can provide time on separate lines for tasks with different activities.

5. Click Done.

Values entered in the effort breakdown are for the time sheet specified in the Use 
Time Sheet field. If you wish to enter values for a different time sheet, select the 
desired time sheet before editing the effort breakdown for a task or summary task.
212 Chapter 11



6. Click Save.

You can open the time sheet being affected anytime from the My Tasks portlet 
by clicking Go To Time Sheet.

Data for tasks that appear in the My Tasks portlet that have actuals will be 
automatically saved to the time sheet when Go To Time Sheet is clicked.
Any unsaved changes that have been made to the effort breakdown are discarded 
when Go To Time Sheet is clicked.
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